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iii. Penggandaan Ciptaan dan/atau produk Hak Terkait hanya untuk

kepetrluan pengajaran, kecuali pertunjukan dan Fonogram yang telah
dilakukan Pengumuman sebagai bahan ajar; dan
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KATA PENGANTAR

Puji syukur kepada Allah SWT, Alhamdulillah penulis
dapat menyelesaikan penulisan buku TEKNIK DAN
APLIKASI MULTIMEDIA & DESAIN GRAFIS. saya
ucapkan buat orang orang yang telah mendukung saya dalam
menyelesaikan buku ini, terutama Kedua Orang Tua saya
Bpk. Samsul Haibuan dan ibu saya Lela Munthe, dan juga
Bpk Sahat Parulian Sebagai Dosen Pembimbing | dan Bpk
Ali Akbar Ritonga Sebagai Dosen Pembimbing II.

Semoga buku ini Bermanfaat dan menjadi amal jariyah
yang Penulis persembahkan khusus kepada kedua orang Tua
kami. Buku ini disusun dalam beberapa bab yang mencakup
berbagai aspek penting dalam multimedia. Pada Bab 1,
pembaca akan diperkenalkan dengan definisi, sejarah,
komponen, danjenis-jenis multimedia. Selain itu, bab ini juga
membahas pentingnya multimedia dalam kehidupan modern
dan penggunaan software desain grafis seperti Adobe
Photoshop dan CorelDRAW, yang merupakan alat penting
dalam menciptakan konten multimedia berkualitas tinggi.

Bab-bab selanjutnya akan mengupas lebih dalam
mengenai elemen-elemen multimedia, perangkat keras dan
perangkat lunak yang digunakan, proses desain dan
pengembangan multimedia, serta aplikasi multimedia dalam
berbagai bidang.

Kami menyadari bahwa buku ini masih jauh dari
sempurna, oleh karena itu kami mengharapkan saran dan
kritik yang membangun dari para pembaca untuk
penyempurnaan edisi berikutnya. Semoga buku ini dapat
memberikan manfaat dan menjadi referensi yang berguna

\Y



bagi para pembaca, khususnya bagi mereka yang
berkecimpung dalam dunia multimedia.

Akhir kata, kami mengucapkan terima kasih kepada
semua pihak yang telah membantu dalam penyusunan buku
ini. Semoga Tuhan Yang Maha Esa senantiasa memberikan
rahmat dan petunjuk-Nya kepada kita semua.

Batu Bara, Juli 2024

Penulis
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BAB |
PENGENALAN MULTIMEDIA

A. Definisi Multimedia

Multimedia adalah media yang menggabungkan
dua unsur atau lebih media yang terdiri dari teks, grafik,
gambar, foto, audio, dan animasi secara terintegrasi.
Multimedia terbagi menjadi dua kategori, yaitu:
multimedia  linear, dan  multimedia interaktif.
Multimedia linear adalah suatu multimedia yang tidak
dilengkapi dengan alat pengontrol apapun yang dapat
dioperasikan oleh pengguna. Multimedia ini berjalan
sekuensial (berurutan), contohnya TV dan film.

Multimedia interaktif adalah suatu multimedia
yang dilengkapi dengan alat pengontrol yang dapat
dioperasikan oleh pengguna, sehingga pengguna dapat
memilih apa yang dikehendaki untuk proses selanjutnya.
Contoh multimedia interaktif adalah: multimedia
pembelajaran interaktif, elearning madrasah, aplikasi
game dan lain-lain.

Sedangkan pembelajaran diartikan sebagai proses
penciptaan lingkungan memungkinkan terjadinya proses
belajar. Jadi dalam pembelajaran yang utama adalah
bagaimana siswa belajar. Belajar dalam pengertian
aktivitas mental siswa dalam berinteraksi dengan



lingkungan yang menghasilkan perubahan perilaku yang
bersifat relatif konstan. Dengan demikian aspek yang
menjadi  penting dalam aktivitas belajar dan
pembelajaran adalah lingkungan. Bagaimana lingkungan
ini diciptakan dengan menata unsur-unsurnya sehingga
dapat merubah perilaku siswa.

Dari uraian di atas dapat disimpulkan bahwa
multimedia pembelajaran dapat diartikan sebagai
aplikasi multimedia yang digunakan dalam proses
pembelajaran, dengan kata lain untuk menyalurkan
pesan (pengetahuan, ketrampilan dan sikap) serta dapat
merangsang pikiran, perasaan, perhatian dan kemauan
yang belajar sehingga secara sengaja proses belajar
terjadi, bertujuan dan terkendali.

1. Manfaat Multimedia Pembelajaran/Learning :

Secara umum manfaat yang dapat diperoleh
adalah proses pembelajaran lebih menarik, lebih
interaktif, jumlah waktu mengajar dapat dikurangi,
kualitas belajar dapat ditingkatkan, dan proses belajar
mengajar dapa t dilakukan dimana dan kapan saja, serta
sikap belajar siswa dapat ditingkatkan.



2. Keunggulan multimedia pembelajaran/learning

a.

Memperbesar benda yang sangat kecil dan tidak
tampak oleh mata, seperti kuman, bakteri,
elektron, dan lain-lain.

Memperkecil benda yang sangat besar, yang
tidak mungkin dihadirkan di sekolah, seperti
gajah, rumah, gunung dan lain-lain.

Menyajikan benda atau peristiwa yang kompleks,
rumit dan berlangsung cepat atau lambat, seperti
sistem tubuh manusia, bekerjanya suatu mesin,
beredarnya planet Mars, berkembangnya bunga
dan lain-lain.

Menyajikan benda atau peristiwa yang jauh,
seperti bulan, bintang, salju dan lain-lain.
Menyajikan benda atau peristiwva yang
berbahaya, seperti letusan gunung berapi,
harimau, racun dan lain-lain.

B. Sejarah dan Perkembangan Multimedia

1. Sejarah Multimedia

Istilah multimedia berawal dari theater, bukan

computer. Pertunjukan yang memanfaatkan lebih dari
satu media seringkali disebut pertunjukan multimedia.
Dimana pertunjukan multimedia mencakup monitor



video, synthesized band dan karya seni manusia sebagai
bagian dari pertunjukan.Sistem multimedia dimulai pada
akhir 1980-an dengan diperkenalkannya Hypercard oleh
Apple pada tahun 1987 dan pengumuman oleh IBM
pada tahun 1989 mengenai perangkat lunak Audio
Visual Connection (AVC) dan video adapter card bagi
PS/2.

Home 2] =]

Sejak permulaan tersebut, hampir setiap pemasok
perangkat keras dan lunak melompat ke multimedia.
Sehingga pada tahun 1994, diperkirakan ada lebih dari
700 produk dan system multimedia di pasaran. Citra
visual dapat dimasukkan ke dalam system dari paket
perangkat lunak yang menyatukan digital, dan dari
kamera video, pita dan piringan video, dan scanner
optic. Input audio dapat dimasukkan melalui microfon,
pita kaset dan compact disk.


https://multimedia14com.wordpress.com/wp-content/uploads/2017/09/screenshot_2017-09-02-13-57-53-1.png

Lewat tahun 70-an pengguna micro komputer
telah dapat mambantu menjelaskan masalah-masalah
dan mempercepat penyelesaian pekerjaan sehari-hari.
Penggunaan komputer juga dapat menyebarkan
informasi dan juga dapat menyajikan hiburan kepada
pengguna komputer dan komputer saat ini bukan
menjadi barang yang baru ataupun mewah tetapi
menjadi suatu kebutuhan. Ini menunjukan efolusi dan
perkembangan  penciptaan  teknologi ~ komputer
multimedia.

2. Perkembangan Multimedia

Pada saat ini, komputer multimedia telah menjadi
suatu kebutuhan, bagi kalangan bisnis ataupun kelompok
masyarakat lainnya. Pada saat ini, informasi tidak cukup
hanya melalui teks dan grafik saja. Sekarang informasi
mencakup kelengkapan teks, grafik, animasi, gambar
dan audio/video. Audio/video, gambar, teks, grafik serta
animasi telah diaplikasikan dalam berbagai bidang,
misalnya untuk bidang pendidikan digunakan sebagai
alat tutorial yang canggih. Multimedia dimanfaatkan
juga dalam dunia pendidikan dan bisnis. Di dunia
pendidikan, multimedia digunakan sebagai media
pengajaran, baik dalam kelas maupun secara sendiri-
sendiri. Di dunia bisnis, multimedia digunakan sebagai
media profil perusahaan, profil produk,



bahkan sebagai media kios informasi dan pelatihan
dalam sistem e-learning.

|Animatiun |
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Gambar 1. 2 Perkembangan Multimedia

Pada awalnya multimedia hanya mencakup
media yang menjadi konsumsi indra penglihatan
(gambar diam, teks, gambar gerak video, dan gambar
gerak rekaan/animasi), dan konsumsi indra pendengaran
(suara). Dalam perkembangannya multimedia mencakup
juga kinetik (gerak) dan bau yang merupakan konsupsi
indra penciuman. Multimedia mulai memasukkan unsur
kinetik sejak diaplikasikan pada pertunjukan film 3
dimensi yang digabungkan dengan gerakan pada kursi
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tempat duduk penonton. Kinetik dan film 3 dimensi
membangkitkan sens rialistis.

Pada masa sekarang ini, hampir semua aktivitas
dapat dilakukan dengan komputer. Setiap waktu orang
dapat melihat perkembangan teknologi dari hari ke hari
dan teknologi tersebut dapat digunakan sebagai alat
bantu manusia untuk menyelesaikan beberapa aktifitas.
Hampir semua kalangan dapat menggunakan komputer
baik dari kalangan bawah sampai kalangan atas. Dan
komputer pada saat ini juga berguna sebagai alat
multimedia

Pada tahun 1998, kita berada empat tahun
menuju ke 20 tahun pengembangan internet sebagai
suatu alat komunikasi global dan berada di mana-mana.
Microsoft telah mencanangkan ambisinya untuk melihat
keberadaan internet di setiap rumah tangga. Sementara
IP secara de facto telah tumbuh sebagai standar dalam
perusahaan-perusahaan besar teknologi informatika,
lantas peran apa yang akan dimainkan oleh satelit
komunikasi dalam bidang ini? Internet dan berbagai jasa
yang berkaitan dengannya adalah perlengkapan yang



mengubah secara mendasar struktur dan jasa
satelit komunikasi. Terdapat empat kunci pengembangan
dalam internet yang mempengaruhi industri satelit
komunikasi.

Pertama, kebutuhan kapasitas besar untuk
pendukung utama (backbone) internet dan penghubung
ISP. Kedua, permintaan akses kecepatan tinggi ke
internet oleh pengguna-akhir. Ketiga, pengembangan
video-on-demand dalam lingkungan internet. Keempat,
permintaan untuk akses secara universal dan ke seluruh
dunia.

Gambar 1. 3 Bagian-bagian Multimedia

Saat ini industri satelit sedang berusaha
mengenali pasarnya dalam lingkungan internet. Industri
satelit tersebut mempunyai banyak rencana untuk


https://multimedia14com.wordpress.com/wp-content/uploads/2017/09/screenshot_2017-09-02-13-58-00-1.png

multimedia dengan pita lebar (broadband). Internet saat
ini merupakan penggerak utama di belakang proyek-
proyek tersebut. Sedikitnya terdapat 111 rencana untuk
multimedia sistem satelit yang meliputi 528 satelit
geostasioner, 874 satelit orbit bumi rendah dan satelit
orbit bumi menengah. Rencana-rencana tersebut datang
dari 69 perusahaan operator satelit yang telah ada
ataupun yang baru muncul. Sebagian besar proyek
satelit multimedia tidak mengumumkan biaya kapital
yang diperkirakan dari proyek mereka. Meskipun
demikian, di antara mereka yang mengumumkan, ada
yang memerlukan pengeluaran kapital sedikitnya 99.5
trilyun dolar AS. Sementara proyek-proyek satelit
multimedia seperti itu sangat menarik perhatian dunia
industri dan publikasi, para operator satelit sibuk
mendayagunakan secara maksimal kapasitas satelit yang
telah ada pada mereka untuk mendukung internet.

3. Perkembangan Multimedia Dalam Bidang
Pendidikan

Pada waktu komputer belum terlalu dikenal di
indonesia, guru dalam menyampaikan pelajaran dengan
tulisan atau lisan. Sekarang penyampaian bahan
pengajaran lebih interaktif dan dapat mempermudah
pembelajaran karena dididukung oleh berbagai aspek:



suara, video, animasi, teks, dan grafik, bahkan
pengajaran secara online (E-learning)



4. Perkembangan Multimedia Dalam Bidang Bisnis

Sejumlah perusahaan memberikan training pada
pegawainya dengan materi training berbasis multimedia
dalam bentuk simulasi. Misalnya: NASA menggunakan
multimedia untuk training flight control bagi calon
astronot.

5. Perkembangan Multimedia Dalam Bidang
Entertainment

Multimedia membuat edukasi menjadi lebih menarik
edutainment, Multimedia sebagai pendukung kegiatan
entertainment animasi dan laser show yang terintegrasi
pada konser musik, Video/musik Player

6. Perkembangan Multimedia Dalam Bidang
Kesehatan

Kini telah terdapat alat-alat medis kedokteran
serba canggih untuk megetahui atau mendeteksi keadaan
tubuh dalam manusia. Seperti USG, Rontgen, Tensi
darah, alat citiscan, HD, dll.



Gambar 1. 4 Contoh USG

7. Perkembangan Multimedia Dalam Bidang Politik

Dalam melakukan aksi kampanye pada jaman
sebelum multimedia belum terlalu berkembang masih
menggunakan lisan atau tulisan di selembaran atau
sticker atau baleho. Kini setelah multimedia berkembang
sangat baik, aksi kampanye telah menyebar ke dunia
maya. Contoh presiden terkini AS Barack Husein
Obama  menggunakan  FaceBook dalam  aksi
kampanyenya.

8. Perkembangan Multimedia Dalam Bidang Industri

a. Industri Komputer
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Industri pada komputer tidak lagi disajikan melalui teks
dan gambar, tetapi juga melalui sumber-sumber yang
diperolehi dari media lain seperti audio dan video.

b. Industri Telekomunikasi

Informasi multimedia juga di proses melalui
perangkat komputer dan dikomunikasikan dengan
wireless atau satelit. Oleh karena informasi multimedia
bersekala besar secara terus menerus sistem komunikasi
data yang sesuai sangat diperlukan. Hal ini
mengakibatkan perubahan terhadap sistem
telekomunikasi yang ada.

Perangkat ~ komunikasi  dahulunya  hanya
menggunakan telephone yang membawa sedikit data dan
lambat yaitu kurang 28 KB, kini telah berubah kepada
wireless yang membolehan lebih banyak data seperti 2
MB, 10 MB dan 622 MB.

c. Industri Penyiaran (Broadcasting)

Pengaruh kepada industri penyiaran pada
mulanya peralatan profesional bagi audio dan video
terdapat di studio rekaman dan pada bagian penyiaran
televisi. Perubahannya pada peralatan tersebut yaitu
dimana sistem-sistem yang lebih profesional telah
digunakan pengeditan movies secara digital informasi



disiarkan melalui kaidah penyiaran yang tersedia seperti
kabel, satelit dan antena.

C. Pentingnya Multimedia Dalam Kehidupan
Sehari-Hari
Dunia saat ini sangat bergantung pada
multimedia dalam kehidupan sehari-hari. Semua sektor
profesi menggunakan multimedia dalam kehidupan
sehari-hari secara langsung atau tidak langsung

untuk  meningkatkan dan  memajukannya.
Multimedia mencakup kombinasi animasi, teks, video,
grafik, gambar, audio, dan bentuk media lainnya yang
dikendalikan komputer. Multimedia menyimpan dan
mengirimkan  semua  informasi  secara  digital.
Multimedia mencakup komponen interaktif seperti
perintah suara, entri teks, manipulasi tetikus, layar
sentuh, perekaman video, atau interaksi langsung
pengguna. Dalam dunia yang serba cepat ini, multimedia
memainkan peran yang halus tetapi penting.

Multimedia digunakan dalam berbagai bidang dan
merupakan profesi yang sama pentingnya, multimedia
terintegrasi ke dalam sekolah.



Sekolah-sekolah secara bertahap mulai beralih ke
digitalisasi. Multimedia meningkatkan dan
memperdalam sesi belajar virtual. Kebutuhan akan
multimedia di sekolah lebih dari sebelumnya karena
pandemi global dan virtualisasi ruang kelas. Untuk
membuat tugas membosankan seperti duduk dan
menatap layar komputer menjadi lebih interaktif serta
menyederhanakannya, multimedia memegang peranan
penting.

a. llmu pengetahuan dan teknologi

Berkat sifat kreatif sains dan teknologi, telah
terjadi beberapa kemajuan besar. Teknologi digunakan
untuk mentransfer dokumen, audio, dan video.
Profesional medis juga menggunakan pemindaian
gambar tubuh untuk mempraktikkan prosedur yang
rumit.  Insinyur menggunakan multimedia untuk
merancang dan membuat prototipe.

b. Iklan

Agen periklanan menggunakan multimedia untuk
membuat teks, gambar, audio, dan video yang menarik
bagi bisnis, produk, dan layanan mereka untuk menarik
pelanggan. Penggunaan multimedia yang inovatif
digunakan dalam iklan produk di televisi, radio, dan
berbagai platform media sosial, misalnya, papan iklan



yang menarik yang membuat Anda melihatnya dan
membaca isinya.

c. Hiburan

Efek khusus dan animasi yang kita semua cintai
dan kagumi semuanya berkat multimedia. Multimedia
dapat membuat hampir semua dunia atau makhluk
imajiner menjadi  hidup. Industri game telah
menggunakan Multimedia  untuk ~ memberikan
pengalaman bermain game yang unik dan serbaguna
serta menghubungkan orang-orang di seluruh dunia yang
selanjutnya meningkatkan pengalaman tersebut.

d. Bisnis

Bisnis  menggunakan  multimedia  dalam
kehidupan sehari-hari  dalam bentuk presentasi,
pelatihan, pemasaran, periklanan, demo produk,
komunikasi jaringan, dll. Multimedia membantu mereka
menarik perhatian pelanggan dan pengunjung serta
berbagi informasi secara efektif. Multimedia adalah
industri yang sedang berkembang dengan peluang yang
luas di berbagai bidang. Mengambil gelar di bidang
multimedia jauh lebih relevan daripada pilihan gelar
tradisional.



1.4 Penggunaan Software Desain Grafis : Photoshop
Dan Coreldraw

Desain grafis merupakan salah satu elemen kunci
dalam pembuatan konten multimedia yang menarik dan
efektif. Dua perangkat lunak yang sangat populer dan
banyak digunakan dalam dunia desain grafis adalah
Adobe Photoshop dan CoreIDRAW.

1.4.1 Adobe Photoshop

Adobe Photoshop adalah salah satu perangkat
lunak pengeditan grafis dan manipulasi gambar yang
paling terkenal dan banyak digunakan di dunia.
Dikembangkan oleh Adobe Inc., Photoshop menawarkan
berbagai alat dan fitur untuk mengedit, memanipulasi,
dan membuat gambar serta desain grafis. Berikut adalah
beberapa poin kunci tentang Adobe Photoshop:

1. Sejarah Adobe Photoshop:

a. Peluncuran Awal (1988): Photoshop pertama kali
dikembangkan oleh Thomas dan John Knoll dan
dirilis oleh Adobe pada tahun 1988. Versi awal ini
dirancang untuk komputer Macintosh dan menandai
awal dari revolusi dalam pengeditan gambar digital.

b. Evolusi dan Versi Berikutnya: Seiring berjalannya
waktu, Photoshop mengalami berbagai pembaruan



besar. Setiap versi baru menambahkan fitur dan
kemampuan tambahan, seperti alat seleksi yang
lebih canggih, kemampuan pemrosesan gambar
yang lebih cepat, dan dukungan untuk berbagai
format file.

Pengembangan Berkelanjutan: Adobe terus
memperbarui  Photoshop dengan fitur-fitur baru
untuk memenuhi kebutuhan para profesional kreatif.
Pembaruan ini sering kali mencakup peningkatan
dalam kemampuan Al (kecerdasan buatan), alat
retouching, dan integrasi dengan perangkat lunak
Adobe lainnya.

. Berbasis Langganan (Creative Cloud): Pada

tahun 2013, Adobe mengalihkan Photoshop ke
model berbasis langganan dengan peluncuran
Adobe Creative Cloud. Ini  memungkinkan
pengguna untuk mengakses versi terbaru dari
Photoshop dan produk Adobe lainnya melalui
langganan bulanan atau tahunan.

Fitur Utama Photoshop:

Pengeditan Gambar: Photoshop memungkinkan
pengguna untuk mengedit foto dan gambar dengan
presisi  tinggi, termasuk perubahan warna,
pemotongan, dan retouching.



b. Manipulasi Gambar: Alat-alat seperti layer,
masking, dan blending modes memungkinkan
pengguna untuk melakukan manipulasi gambar
kompleks dan menciptakan efek visual yang
menakjubkan.

c. Desain Grafis: Photoshop juga digunakan untuk
desain grafis, termasuk pembuatan poster, brosur,
dan materi pemasaran lainnya.

d. Kreativitas Digital: Dengan berbagai filter, efek,
dan alat desain, Photoshop adalah alat utama untuk
ilustrasi digital dan karya seni berbasis raster.

e. Integrasi dan Ekstensi: Photoshop terintegrasi
dengan produk Adobe lainnya, seperti Illustrator
dan InDesign, serta mendukung ekstensi dan plugin
yang dapat menambahkan fungsionalitas tambahan.

Photoshop adalah standar industri dalam pengeditan
gambar dan desain grafis, dan terus menjadi alat utama
bagi fotografer, desainer grafis, dan profesional kreatif
di seluruh dunia.
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Gambar 1. 5 Adope Photoshop

1.4.2 CoreDRAW

CoreIDRAW adalah perangkat lunak desain
grafis yang dikembangkan oleh Corel Corporation. Ini
adalah alat yang sangat populer di kalangan desainer
grafis, ilustrator, dan profesional kreatif lainnya karena
kemampuannya untuk membuat desain vektor, yang
berarti grafik yang dapat diperbesar atau diperkecil tanpa
kehilangan kualitas.

1. Sejarah CoreIDRAW:

a. Peluncuran Awal (1989): CoreIDRAW pertama kali
diluncurkan pada tahun 1989. Versi awal ini
dirancang untuk sistem operasi Windows dan



langsung mendapatkan perhatian karena
kemampuannya yang kuat dan antarmuka pengguna
yang intuitif.

Perkembangan dan Versi Berikutnya: Seiring waktu,
CoreIDRAW mengalami berbagai pembaruan dan
peningkatan fitur. Setiap versi baru membawa
perbaikan dan fitur tambahan, seperti alat desain
yang lebih canggih, dukungan untuk berbagai
format file, dan peningkatan dalam antarmuka
pengguna.

CoreIDRAW  Suite:  CoreIDRAW  seringkali
dikemas dalam paket yang disebut CorelDRAW
Graphics Suite, yang mencakup berbagai alat desain
grafis tambahan seperti Corel PHOTO-PAINT
(untuk pengeditan foto), Corel Font Manager, dan
alat-alat lainnya.

Evolusi Teknologi: Dengan berjalannya waktu,
CoreIDRAW terus beradaptasi dengan
perkembangan teknologi grafis dan perangkat keras.
Versi terbaru dari CorelDRAW dirancang untuk
memanfaatkan kemampuan komputer modern dan
memenuhi kebutuhan desain grafis profesional.

Cloud dan Kolaborasi: Baru-baru ini, CoreDRAW
juga memperkenalkan fitur-fitur berbasis cloud
untuk memfasilitasi kolaborasi dan akses desain dari



berbagai perangkat, membuatnya lebih fleksibel
dalam lingkungan kerja yang dinamis.

CoreIDRAW dikenal karena kemampuannya
dalam menangani berbagai jenis desain grafis, termasuk

ilustrasi, desain logo, pembuatan brosur, dan banyak
lagi.
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Gambar 1. 6 CorelDRAW




BAB Il
ELEMEN-ELEMEN MULTIMEDIA

Multimedia adalah istilah yang digunakan untuk
menggambarkan penggunaan berbagai jenis media
secara bersamaan dalam satu presentasi atau aplikasi. Ini
dapat mencakup teks, gambar, suara, video, animasi, dan
grafik. Multimedia sering digunakan dalam berbagai
konteks, mulai dari pendidikan dan hiburan hingga
pemasaran dan desain grafis. Berikut adalah beberapa
aspek dan aplikasi utama dari multimedia:

1. Aspek Multimedia:

a. Teks: Informasi yang disampaikan dalam bentuk
kata-kata. Ini bisa berupa judul, deskripsi, atau
konten naratif dalam multimedia.

b. Gambar: Visual statis yang bisa berupa foto,
ilustrasi, atau grafik. Gambar sering digunakan
untuk memperjelas atau menambahkan konteks
pada informasi.

c. Suara: Elemen audio yang dapat berupa musik,
suara narasi, atau efek suara. Suara membantu
menciptakan pengalaman yang lebih imersif dan
dapat meningkatkan pemahaman serta keterlibatan.



. Video: Konten visual bergerak yang menyampaikan
informasi dalam format waktu nyata. Video sering
digunakan untuk presentasi, tutorial, dan hiburan.

Animasi: Grafis yang bergerak yang digunakan
untuk menjelaskan konsep atau menambah elemen
visual dinamis. Animasi sering ditemukan dalam
video game, film, dan presentasi.

Grafik Interaktif: Elemen yang memungkinkan
pengguna untuk berinteraksi dengan konten, seperti
tombol, menu, atau elemen kontrol yang dapat
diklik.

. Aplikasi Multimedia:

Pendidikan: Multimedia digunakan dalam e-
learning dan kursus online untuk membuat materi
pembelajaran lebih menarik dan mudah dipahami.
Video tutorial, animasi, dan simulasi interaktif
adalah beberapa contoh.

Hiburan: Industri hiburan menggunakan
multimedia dalam film, video game, dan musik.
Efek visual, animasi, dan suara berkualitas tinggi
sangat penting dalam menciptakan pengalaman
hiburan yang menarik.

Pemasaran dan Periklanan: Multimedia
digunakan dalam iklan digital, video promosi, dan



kampanye pemasaran untuk menarik perhatian
audiens dan menyampaikan pesan dengan cara yang
efektif.

Desain Grafis: Dalam desain grafis, multimedia
memungkinkan pembuatan materi pemasaran yang
kompleks dan menarik, termasuk brosur, poster, dan
situs web.

Seni dan Kreativitas: Seniman menggunakan
multimedia untuk menciptakan karya seni yang
menggabungkan berbagai media, seperti instalasi
seni yang mencakup video, suara, dan elemen
interaktif.

Komunikasi:  Multimedia  digunakan  dalam
komunikasi bisnis dan pribadi untuk presentasi yang
lebih efektif, laporan visual, dan komunikasi yang
lebih dinamis.

Multimedia adalah alat yang kuat untuk
menyampaikan informasi dengan cara yang menarik
dan interaktif, meningkatkan pengalaman pengguna,
dan memungkinkan kreativitas dalam berbagai
bidang.



2.1 Teks

Teks adalah elemen dasar dalam multimedia
yang digunakan untuk menyampaikan informasi dalam
bentuk tulisan. Teks dapat digunakan sebagai judul,
deskripsi, atau konten utama. Dalam pembuatan konten
multimedia, pemilihan font, ukuran, warna, dan tata
letak yang tepat sangat penting untuk memastikan
keterbacaan dan keterikatan visual.

2.1.1 Fungsi Teks

Teks berfungsi untuk memberikan informasi
secara langsung, memberikan penjelasan tambahan, atau
menekankan poin-poin  penting. Dalam konteks
multimedia, teks juga dapat digunakan untuk
menyampaikan instruksi atau narasi.

2.1.2 Jenis Teks

Terdapat berbagai jenis teks yang digunakan
dalam multimedia, termasuk teks judul (headline),
subjudul (subheadline), teks isi (body text), dan teks
navigasi (navigational text). Setiap jenis teks memiliki
peran yang berbeda dalam menyampaikan informasi.

2.1.3 Prinsip Desain Teks

Dalam mendesain teks untuk multimedia,
beberapa prinsip utama yang harus diperhatikan
meliputi:



a. Keterbacaan: Teks harus mudah dibaca. Pemilihan
font, ukuran, dan kontraswa  rna sangat
berpengaruh terhadap keterbacaan.

b. Keseragaman: Gunakan font dan gaya Yyang
konsisten untuk menjaga keseragaman visual.

c. Keterlibatan Visual: Gunakan teks secara kreatif
untuk menarik perhatian dan mempertahankan
minat pembaca.

Menurut sejarah, asal-usul bentuk huruf
ini adalah mengikuti bentuk pilar-pilar
bangunan di Yunani Kuno. Seperti
diketahui, bagian atas dan bawah tiang

pilar memang lebih besar agar bisa
membuat pilar lebih kokoh.

Contoh : font Times New Roman, Bodoni,
Garamond, atau Egyptian

Gambar 2. 1 Contoh Elemen Teks

2.2 Grafik dan Gambar
Grafik dan gambar membantu menyampaikan
informasi secara visual dan dapat meningkatkan daya
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tarik konten multimedia. Grafik dapat berupa
ilustrasi, diagram, dan infografis, sementara gambar
biasanya berupa foto atau gambar digital.

2.2.1 Fungsi Grafik dan Gambar

Grafik dan gambar berfungsi untuk:

a. Menyederhanakan informasi yang kompleks.
b. Menambah daya tarik visual.

¢. Membantu menggambarkan konsep atau ide.
2.2.2 Jenis Grafik dan Gambar

a. lustrasi: Gambar yang dibuat untuk menjelaskan
atau menghiasi teks.

b. Diagram: Representasi grafis dari data atau
informasi.

c. Infografis: Kombinasi dari grafik dan teks untuk
menyampaikan informasi secara visual.

d. Foto: Gambar yang diambil dengan kamera
untuk memberikan representasi visual yang
realistis.

2.2.3 Prinsip Desain Grafik dan Gambar



a. Relevansi: Pastikan grafik dan gambar relevan
dengan konten yang disajikan.

b. Kualitas: Gunakan gambar dengan resolusi tinggi
untuk menghindari penurunan kualitas visual.

c. Keseimbangan Visual: Tata letak grafik dan
gambar harus seimbang dengan elemen teks dan
elemen lainnya.
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Gambar 2. 2 Contoh grafik dan gambar

2.3 Audio

Audio mencakup suara, musik, dan efek suara
yang digunakan untuk memperkaya pengalaman
multimedia. Audio dapat meningkatkan suasana,
memberikan penjelasan tambahan, atau menyampaikan
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informasi yang tidak dapat disampaikan melalui teks
atau gambar.

2.3.1 Fungsi Audio

a.

Meningkatkan Atmosfer: Musik latar dan efek suara
dapat menciptakan suasana tertentu.

Menjelaskan Informasi: Narasi atau dialog dapat
memberikan penjelasan tambahan.

Menarik Perhatian: Suara dapat digunakan untuk
menarik perhatian pengguna atau memberikan
umpan balik.

2.3.2 Jenis Audio

a.

Musik: Digunakan sebagai latar belakang untuk
menciptakan suasana atau mendukung emosi.

Efek Suara: Suara khusus yang digunakan untuk
menandai tindakan atau peristiwa tertentu.

Narasi: Penggunaan suara manusia untuk
memberikan penjelasan atau bercerita.

2.3.3 Prinsip Desain Audio

a.

Kualitas: Gunakan audio berkualitas tinggi untuk
menghindari gangguan pendengaran.



Keselarasan: Pastikan audio selaras dengan elemen
visual dan tidak mengganggu fokus pengguna.

Volume yang Tepat: Atur volume audio agar tidak
terlalu keras atau terlalu pelan.

2.4 Video
Video adalah elemen multimedia yang

menggabungkan gambar bergerak dan audio untuk
menyampaikan informasi atau cerita. Video dapat
digunakan untuk demonstrasi, tutorial, hiburan, dan
banyak lagi.

2.4.1 Fungsi Video

a.

Menyampaikan Informasi: Video dapat menjelaskan
konsep yang kompleks dengan cara yang mudah
dimengerti.

Menghibur: Video dapat digunakan untuk hiburan,
seperti film atau animasi.

Mengajar:  Video  tutorial dan  e-learning
memanfaatkan video untuk mengajarkan
keterampilan dan pengetahuan.

2.4.2 Jenis Video



Video Pendidikan: Digunakan untuk tujuan
edukatif.

Video Promosi: Digunakan untuk mempromosikan
produk atau layanan.

Video Dokumenter: Menggambarkan peristiwa
nyata atau memberikan informasi faktual.

2.4.3 Prinsip Desain Video

a.

Kualitas Visual: Gunakan video dengan resolusi
tinggi dan pencahayaan yang baik.

Kualitas Audio: Pastikan audio dalam video jelas
dan bebas dari gangguan.

Penyuntingan yang Efektif: Potong bagian yang
tidak perlu dan tambahkan efek transisi yang halus.



Gambar 2. 3 Contoh Video menggunakan Adobe
PriemerPro

2.5 Animasi

Animasi adalah teknik membuat gambar
bergerak dengan menampilkan serangkaian gambar
statis secara cepat. Animasi dapat digunakan untuk
menjelaskan konsep yang kompleks, membuat konten
lebih menarik, dan menambah elemen interaktif.

2.5.1 Fungsi Animasi

a. Menggambarkan Proses: Animasi dapat
menunjukkan bagaimana sesuatu bekerja atau
terjadi.

b. Menambah Daya Tarik: Animasi dapat membuat
konten lebih dinamis dan menarik.
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c. Meningkatkan ~ Pemahaman:  Animasi  dapat
membantu menjelaskan konsep yang sulit dengan
cara visual.

2.5.2 Jenis Animasi

a. Animasi 2D: Gambar bergerak yang dibuat dalam dua
dimensi.

b. Animasi 3D: Gambar bergerak yang dibuat dalam
tiga dimensi, memberikan kedalaman dan realisme.

c. Motion Graphics: Kombinasi teks dan elemen grafis
yang bergerak.

2.5.3 Prinsip Desain Animasi

a. Kehalusan Gerakan: Pastikan animasi bergerak
dengan lancar tanpa patah-patah.

b. Relevansi: Animasi harus relevan dengan konten dan
tidak terlalu mencolok.

c. Durasi yang Tepat: Jaga durasi animasi agar tidak
terlalu panjang atau terlalu singkat.
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Gambar 2. 4 Contoh animasi menggunakan Adobe Flash

2.6 Interaktivitas

Interaktivitas memungkinkan pengguna untuk
berinteraksi dengan konten multimedia, memberikan
kontrol lebih terhadap bagaimana mereka menerima
informasi. Bentuk interaktivitas termasuk tombol
navigasi, formulir, kuis, permainan, dan simulasi.

2.6.1 Fungsi Interaktivitas

a. Meningkatkan Keterlibatan: Interaktivitas membuat
pengguna lebih terlibat dengan konten.
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Memberikan Kontrol: Pengguna dapat memilih
bagaimana mereka berinteraksi dengan informasi.

Memperkuat Pembelajaran: Interaktivitas dapat
digunakan dalam e-learning untuk menguji
pemahaman dan memberikan umpan balik.

2.6.2 Jenis Interaktivitas

a.

Navigasi: Tombol dan menu yang memungkinkan
pengguna untuk menavigasi konten.

Formulir:  Input teks dan pilihan yang
memungkinkan pengguna untuk berinteraksi dengan
konten.

Kuis dan Tes: Elemen interaktif yang digunakan
untuk menguji pengetahuan pengguna.

Simulasi: Model interaktif yang memungkinkan
pengguna untuk berlatih atau mengeksplorasi.

2.6.3 Prinsip Desain Interaktivitas

a.

b.

Kesederhanaan: Buat elemen interaktif yang mudah
dipahami dan digunakan.

Responsivitas: Pastikan elemen interaktif
memberikan umpan balik yang cepat dan jelas.



c. Relevansi: Pastikan interaktivitas relevan dengan
konten dan tujuan pembelajaran.



BAB IlII

PERANGKAT KERAS DAN PERANGKAT
LUNAK MULTIMEDIA

3.1 Perangkat Keras Multimedia

Perangkat keras yang dibutuhkan untuk
multimedia dapat dikelompokkan menjadi lima, yaitu
perangkat konektor, input, output, penyimpan, dan
perangkat komunikasi.

A. Perangkat Konektor

Di antara beberapa perangkat komputer, monitor,
hardisk, video proyektor, speaker. dan perangkat-
perangkat lain, terdapat terdapat kabel-kabel yang
menghubungkan. Kecepatan transfer data perangkat
konektor yang digunakan akan menentukan kecepatan
pengiriman konten multimedia.

Berikut beberapa perangkat konektor yang biasa
digunakan.

1. Small Computer System Interface (SCSI).

SCSI merupakan perangkat standar untuk
penghubung secara fisik dan pertukaran data antara
komputer dan peripheral. Standar SCSI mendefinisikan



perintah, protokol, serta antarmuka elektrik dan optik.
SCSI biasa digunakan untuk hard disk.

Gambar 3. 1 Contoh small computer system interface
(SCsI)

2. Media Control Interface (MCI).

MCI merupakan perpanjangan dari APl untuk
mengendalikan peripheral multimedia yang terhubung
dengan computer. MCI terdiri dari empat bagian, yaitu
AVI video, CD audio, sequencer, dan wave audio.

Gambar 3. 2 Contoh Media control interface (MCI)
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3. Intergrated Drive Electronic (IDE).

Antarmuka IDE merupakan standard untuk
media penyimpan yang terhubung ke komputer.

(INTEGRATED DRIVE ELECTRONICS)

Gambar 3. 3 Contoh intergrated drive electronic (IDE)

4. Universal Serial Bus (USB)

USB merupakan standard bus serial untuk
menghubungkan beberapa perangkat. USB didesain
untuk memungkinkan berbagai
periferal terhubung menggunakan soket antarmuka
standar dan memiliki kemampuan plug and play.
Artinya, perangkat
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dapat dipasang dan dilepas tanpa harus mematikan
komputer terlebih dahulu.

Gambar 3. 4 Contoh universal serial bus (USB)

5. High-Definition Multimedia Interface (HDMI)

HDMI adalah standar koneksi digital yang
dirancang untuk menampilkan gambar dan suara resolusi
tinggi. Kelebihannya ialah kabel HDMI dapat
menampilkan gambar full-HD, surround sound, control
signal, bahkan data ethernet, hanya dengan satu kabel.

Gambar 3. 5 Contoh High-Definition Multimedia
Interface
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B. Perangkat Input

Perangkat input adalah perangkat yang berfungsi
untuk mentransformasi informasi dari dunia luar untuk
diolah oleh komputer. Perangkat input biasanya
dikendalikan secara langsung oleh pengguna. Berikut
beberapa perangkat input tersebut.

1. Keyboard

2. Perangkat pointing (mouse, touchpad, touchscreen,
trackball, lightpen).

3. Perangkat input gambar dan video (scanner,
webcam).

4. Perangkat input audio (microphone).

C. Perangkat Output

Perangkat output adalah perangkat yang
digunakan untuk mengomunikasikan hasil pengolahan
data dari komputer kepada
pengguna. Perangkat output antara lain speaker,
amplifier, monitor, proyektor, printer.

D. Perangkat Penyimpan



Perangkat penyimpan adalah perangkat untuk
merekam atau menyimpan informasi (data). Perangkat
penyimpan dapat digunakan untuk menahan maupun
memproses data. Berikut beberapa perangkat penyimpan
tersebut.

1. Random ACCESS MEMORY (RAM)

RAM merupakan memori utama yang digunakan
untuk inisialisasi sistem operasi dan juga program
aplikasi. RAM bersifat volatile.

Setiap program yang diakhiri/ditutup, akan dihapus dari
RAM. Semakin besar kapasitas RAM, semakin cepat
waktu pemprosesan.

Gambar 3. 6 Contoh random access memory (RAM)

2. Read Only Memory (ROM)

ROM  bersifat non-volatile. ROM  biasa
digunakan pada komputer untuk menyimpan program
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BIOS vyang digunakan untuk inisialisasi booting
komputer. Pada printer, ROM digunakan untuk
menyimpan font.

Gambar 3. 7 Contoh read only memory (ROM)
3. Hardisk

Hardisk merupakan perangkat penyimpan untuk
data biner yang mudah dibaca oleh komputer.
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Gambar 3. 8 hardisk

4. Compact Disk (CD)

CD adalah media penyimpanan yang berbentuk
piringan. CD disebut juga optik pada generasi pertama
yang menggantikan disket (floppy disc) pada waktu itu.
Ini karena CD memiliki kapasitas penyimpanan yang
lebih besar dengan harga yang sama.

CD banyak digunakan untuk membuat film
dengan resolusi kecil atau sebagai media transmisi
software-software aplikasi. CD memiliki kapasitas
penyimpanan data 700 MB.
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Gambar 3. 9 compact disk (CD)
5. Digital Versatile Disk (DVD)

DVD adalah media penyimpanan optik yang
populer. Penggunaan utamanya untuk menyimpan video
dan data. Sesuai dengan namanya, ukuran fisik
standarnya sama dengan CD (compact disc), tetapi
dengan kapasitas enam kali lipat dari CD.

E. Perangkat komunikasi

Aplikasi multimedia dibuat oleh tim yang terdiri
dari beberapa orang yang bisa jadi bekerja dalam satu
gedung, tetapi dapat pula bekerja pada gedung yang
berlainan dan  berjauhan jaraknya. Karenanya,
dibutuhkan perangkat komunikasi untuk saling
menghubungkan mereka. Perangkat komunikasi tersebut
antara lain modem dan ISDN.
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3.2 Perangkat Lunak Multimedia

Perangkat lunak multimedia adalah komponen-
komponen dalam data processing system berupa
program-program untuk mengontrol bekerjanya sistem
komputer multimedia. Perangkat lunak ini digolongkan
menjadi tiga bagian yaitu bahasa pemrograman
multimedia, perangkat lunak sistem multimedia, dan
perangkat lunak aplikasi multimedia.

A. Bahasa Pemprograman Multimedia

Bahasa pemprograman multimedia ialah bahasa-
bahasa yang digunakan programmer untuk membuat
aplikasi multimedia. Contohnya Assembly, C, C++,
Power Builder, Delphi, SQL, Visual Basic, dan Java.

B. Perangkat Lunak Sistem (System Software)

Perangkat lunak ini terdiri dari sistem operasi
(operating system) semisal DOS (disc operating system),
Windows 95/98/ME, Windows NT/2000, Windows XP,
Windows Vista, UNIX, Linux, atau Mac OS. Perangkat
lunak lain ialah aplikasi utilitas (utility application)
semisal aplikasi antivirus.

C. Perangkat Lunak Aplikasi Multimedia

Perangkat lunak aplikasi multimedia merupakan
aplikasi-aplikasi yang dibuat oleh personal atau
organisasi untuk user yang beroperasi dalam bidang-



bidang multimedia spesifik seperti grafik 2D, modeling,
dan animasi. Berikut rinciannya.

1. Perangkat pengolah teks.

Aplikasi pengolah teks yang banyak digunakan
seperti Microsoft Word, Word Star for Windows, Word
Perfect, dan Star Writer. Sedangkan beberapa aplikasi
pengolah teks yang bersifat open source yakni Open
Writer, KWriter. dan Abi Word.

2. Perangkat lunak pengolah animasi dan grafik 2D.

Aplikasi pengolah grafik 2D dibagi menjadi dua bagian.
Grafik 2D Vector, seperti Corel Draw, Macromedia
Freehand dan Adobelllustrator. Grafik 2D Image
(Raster), semisal Adobe Photoshop, Jasc Paint Shop Pro,
Gimp. Animasi, misalnya Macromedia Flash.

3. Perangkat lunak pengolah animasi dan modeling
grafik 3D.Contoh dari perangkat lunak animasi dan
modeling grafik 3D ialah 3D Studio MAX, Maya,
Softimage, LightWave, dan Blender.

4. Perangkat lunak authoring multimedia. Authoring
merupakan aplikasi komputer yang memberikan peluang
kepada pengguna untuk mengembangkan
perangkat lunak dengan dragging dan dropping berbagai
objek multimedia tanpa harus mengetahui penggunaan
dan pemahaman bahasa pemrograman, seperti



Macromedia Authoring. Sedangkan aplikasi authoring
yang dilengkapi  dengan  pemrograman  yakni
Macromedia Director dengan dilengkapi Lingo (Bahasa
pemrograman).

Jenis perangkat itu dibagi menjadi tiga kategori
yaitu authoring berbasis halaman, authoring berbasis
ikon, dan authoring berbasis waktu. Authoring berbasis
halaman merupakan authoring yang bekerja berbasis
halaman atau buku dengan mengorganisasi elemen-
elemen dalam halaman atau buku tersebut. Contoh dari
aplikasi ini ialah HyperCard dan ToolBook Assistant.

Authoring berbasis ikon menggunakan konsep
flowchart untuk membuat aliran elemen-elemen
multimedia yang dihubungkan bersama atau secara
sendiri-sendiri  yang secara khusus menampilkan
diagram alir aktivitas sepanjang jalur percabangan.
Contohnya Microsoft Power Point dan Macromedia
Authorware.

Authoring berbasis waktu merupakan
pengembangan paket multimedia sebagai
pengorganisasian objek sepanjang lini waktu. Frame
yang diorganisasikan secara berurut kemudian
ditampilkan kembali kepada pengguna. Contoh aplikasi
yang menggunakan cara ini ialah Macromedia Director.



Authoring DVD adalah aplikasi yang digunakan
untuk menampilkan menu interaktif movie. Contohnya,
Pinnacle
Impression, Sonic ReelDVD, dan Ulead DVD
Workshop.

E. Perangkat Lunak Aplikasi Berbasis Web

Contoh produk-produk mendesain web antara
lain Macromedia Flash yang digunakan untuk membuat
animasi grafis pada web, Macromedia Dreamweaver,
dan Microsoft Front Page.

3.3 Platform dan Alat Pengembangan Multimedia

Seorang pendidik memiliki tugas utama untuk
menyampaikan materi dan informasi kepada peserta
didik secara efektif. Agar proses pembelajaran efektif
dan bisa menarik perhatian murid diperlukan berbagai
macam persiapan dan juga kreativitas para guru.

Salah satu cara adalah dengan menyiapkan dan
mengembangkan media pembelajaran yang cocok
dengan materi dan karakteristik peserta didik.

Adapun media pembelajaran yang disiapkan
untuk pembelajaran di era digital saat ini tentu saja perlu
juga disesuaikan dengan tren dan perkembangan



pembelajaran. Sehingga diperlukan kreativitas dari guru
dalam mengembangkan sebuah media pembelajaran agar
menjadi menarik dan interaktif.

Saat ini ketika proses pembelajaran dilakukan
secara jarak jauh, maka media pembelajaran yang
populer digunakan adalah multimedia interaktif seperti
video pembelajaran, games digital, buku digital, power
point dan lainnya.

Untuk  mengembangkan dan  menyiapkan
multimedia pembelajaran yang baik tentu saja selain
membutuhkan keterampilan juga memerlukan aplikasi
dan software yang  berfungsi  sebagai alat untuk
mengembangkan media pembelajaran tersebut.

Berikut ada beberapa daftar aplikasi
dan software yang bisa dicoba oleh Anda untuk
mengembangkan multimedia pembelajaran khususnya
yang berbasis digital.

1. Canva

Canva merupakan salah satu aplikasi pengolah
grafis atau visual yang populer digunakan saat
ini. Canva merupakan aplikasi pengolah grafis
berbasis cloud sehingga apabila ingin digunakan Anda
harus terhubung dengan internet.



Canwva

Gambar 3. 10 logo canva

Sebagai pendidik Anda bisa memanfaatkan
Canva untuk keperluan desain visual media
pembelajaran Anda, seperti membuat infografis,
rangkuman materi, worksheet, brosur, poster, template
presentasi, thumbnail YouTube dan kebutuhan grafis
sederhana lainnya.

Membuat desain visual di Canva juga semakin
mudah karena setiap tipe desain dikelompokkan
berdasarkan  kategori  masing-masing.  Terdapat
setidaknya tujuh kategori yaitu media sosial, dokumen,
personal, pendidikan, marketing, event, dan iklan.

Anda bisa langsung menggunakan aplikasi ini
melalui website canva.com atau melalui aplikasi mobile-
Nyayang tersedia di playstore dan apple store. Ingat,
Anda perlu membuat akun terlebih dahulu sebelum
menggunakan aplikasi ini.

| 4 |




Kelebihan:

1). tampilan antarmuka sederhana;

2). Memiliki ribuan template;

3). Tidak perlu diinstal di komputer;

4). Menghemat pemakaian ruang penyimpanan;
5). Bisa digunakan melalui smartphone.

Kekurangan:

1). Tidak bisa diakses tanpa koneksi internet;

2). Tidak bisa eksport file sumber;

3). Tidak bisaeksport filedengan latar belakang
transparan (fitur premium);

4). Tidak bisa export file GIF dan video (
fitur premium).

2. Powtoon

Powtoon merupakan aplikasi presentasi dan
video animasi interaktif. Anda bisa menggunakan
aplikasi ini untuk kebutuhan media pembelajaran seperti
presentasi, video animasi, infografis bergerak, dan
lainnya. Dengan menggunakan Powtoon penjelasan
konsep materi Anda bisa lebih jelas dan bisa mengatasi
keterbatasan ruang, waktu, dan indera.
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POWTOON

Gambar 3. 11 Contoh logo powtoon

Powtoon memiliki beragam fitur
dan template yang akan membantu memudahkan proses
pembuatan  media  pembelajaran.  Anda  bisa
menambahkan character, text effect,
animation, link, background, dan lainnya. Anda juga
bisa sekaligus menggerakan karakter dan teks sesuai
kebutuhan dengan hanya memilih effect dan pose yang
tersedia.

Setelah  mengedit Anda bisa langsung
mempublikasi ke YouTube, Facebook dan lainnya. Anda
juga bisa menyimpan atau export dalam beberapa format
lainnya seperti MP4, PDF, dan PPT.

Anda bisa menggunakan Powtoon langsung dari
web powtoon.com atau melalui aplikasi mobile-Nya.
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Kelebihan:

1). Bisa membuat pembelajaran lebih menarik dan
interaktif;

2). Penggunaanya yang praktis;

3). Memiliki karakter dan animasi yang menarik;

4). Menstimulus berbagai indera (penglihatan dan
pendengaran);

5). Dapat digunakan dalam kelompok besar dan
kolaboratif;

6). Dapat memberikan feedback.

Kekurangan:

1). Durasi yang terlalu singkat;

2). Proses pembuatan harus terhubung dengan internet;
3). Tidak bisa diberi musik latarbelakang;

4). Membutuhkan kreativitas lebih agar hasilnya lebih
menarik.

3. Prezi

Prezi merupakan aplikasi (software) untuk
membuat dan mengelola presentasi secara online. Prezi
memiliki kemiripan dengan
aplikasi powerpoint maupun google slide.
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Gambar 3. 12 Contoh logo prezi

Salah satu fitur utama yang dimiliki Prezi yaitu
menggunakan Zooming User Interface (ZUI), yang
memungkinkan  Anda untuk memperbesar dan
memperkecil tampilan media presentasi secara fleksibel
dan dinamis. Anda juga memiliki pilihan untuk membuat
presenteasi dengan mode linear. Mode linear memiliki
karakteristik slide yang berurutan.

Prezi dapat digunakan secara online maupun
secara offline. Untuk akses online Anda bisa langsung
mengunjungi prezi.com, sementara untuk akses offline
Anda perlu menginstall masternya terlebih dahulu.
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Fitur utama prezi diantaranya Prezi
Present(untuk presentasi), Prezi Video (untuk video
interaktif), dan Prezi Design(untuk desain). Dengan
menggunakan prezi diharapkan bisa membuat kbm
online Anda menjadi lebih menarik dan interaktif.

Kelebihan: 1). Tampilan tema dan templateyang lebih
variatif dibandingkan PPT; 2). Lebih menarik dan
interaktif karena menggunakan teknologi ZUI; 3). Lebih
mudah dalam membuat animasi; 4). Kualitas
pembelajaran lebih baik dan sistematis.

Kekurangan: 1). Terlihat monoton karena hanya
menggunakan teknologi ZUI; 2). Instalasi dan
penggunaan aplikasi membutuhkan koneksi internet; 3).
Sulit memasukkan simbol matematika.

4. Sparkol VideoScribe

Merupakan software presentasi video white
board dengan menggunakan animasi tulisan tangan
dengan latar belakang seperti papan

tulis. Sparkol mampu menjadi alat pengembangan media
pembelajaran yang interaktif karena memiliki kombinasi
animasi dan template yang menarik.
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VideoScribe

created by SPARKOL

Gambar 3. 13 Sparkol videoscribe

Anda bisa menggunakan software ini secara
online melalui videoscribe.co maupun secara offline.
Untuk penggunaan gratis Anda diberi waktu percobaan
selama 30 hari dan setelah itu diharuskan menggunakan
versi berbayar. Terdapat banyak aset animasi, gambar,
ikon, dan efek yang bisa membantu mempercantik dan
memperjelas informasi Anda.

Kelebihan: 1).Memiliki aset gambar dan animasi yang
beragam; 2). Tampilan antarmuka yang sederhana; 3).
Bisa Memasukan musik danvoice over sebagai
backsound dari sparkol maupun musik pilihan sendiri;
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4). Dapat di export dengan format mp4 dan wav serta
bisa langsung dipublikasi di media sosial.

Kekurangan: 1). Untuk memperoleh akses dan fitur
penuh perlu berlangganan; 2). Perlu spesifikasi
komputer / laptop yang baik agar tidak lambat dan
bemasalah saat mengedit.

5. Lectora

Merupakan software dan tool pengembangan e-
learning. Lectore bisa digunakan untuk berbagai
kebutuhan pembelajaran terkhusus untuk pembuatan
presentasi, kuis, bahkan game pembelajaran berbasis
flash. Anda bisa menyisipkan video, gambar, game,
soal-soal evaluasi, lembar tes, dan lainnya secara mudah.



Lectora
INSPIRE

Gambar 3. 14 logo lectora

Ketika menginstall Lectora sudah disertai dengan
aplikasi pendukung seperti Camtasia (merekam layar),
flypaper (menggabungkan gambar dan animasi) dan
snagit (print/capture layar monitor).

Dengan menggunakan Lectora Anda dapat
membuat  media  pembelajaran e-learning menjadi
menarik. Anda bisa membuat materi presentasi,
menambah contoh latihan soal, memasukkan gambar
dan video, serta lainnya.

Kelebihan: 1). Mudah dipakai oleh siapapun 2).
Multifungsi, yaitu bisa digunakan untuk membuat
website, konten E-Learning, kuis, lainnya; 3).
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Menyediakan banyak library template, clipart dan efek;
4). Bisa dipublikasi dalam berbagai format gambar,
audio dan video; 5). Ada fitur khusus membuat games
berbasis flash yang disertai fitur evaluasi.

Kekurangan: 1). Membutuhkan spesifikasi
komputer/laptop yang lumayan bagus; 2). Media
pendukung cukup mahal; 3). Efektivitas penggunaan
media tergantung materi dan penyaji.

6. Sigil

Merupakan aplikasi yang digunakan untuk
membuat dan mengelola buku digital (ebook). Aplikasi
ini selain gratis juga memiliki fitur yang lengkap. Anda
bisa mengembangkan ebook yang menarik agar siswa
lebih termotivasi dalam membaca.

Gambar 3. 15 logo sigil
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Sigil merupakan salah satu Epub (electronic
Publication) yang banyak digunakan karena mudah
digunakan. Sigil juga mendukung beragam format
seperti teks, gambar audio dan video yang bisa
disisipkan dalam buku digital agar menjadi lebih
interaktif. Format yang didukung juga sangat lengkap
seperti Epub, HTML, dan lainnya.

Anda bisa memasukkan materi, Kkuis, video,
audio, latihan soal SD dan jenjang di atasnya, serta
konten lainnya dalam buku digital Anda agar lebih
menarik.

Sigil bisa diakses melalui aplikasi dekstop,
browser dan perangkat mobile. Anda bisa
membuka output ebook melalui berbagai macam aplikasi
pembaca buku digital.

Kelebihan: 1). Mendukung berbagai macam format;
2). Output bisa dibaca pada banyak platform (mobile dan
desktop); 3). Open Source;4). Mudah digunakan dan
bisa mengubah tampilan layar kerja; 5). Memiliki
fasilitas terjemahan; 6). Publikasi yang mudah dan
murah dan bersifat protable.

Kekurangan: 1). Masih sering terjadi bug dan masalah
pada aplikasi; 2). Mudah disebarluaskan sehingga rentan
terjadi penyalahgunaan hak cipta; 3). Butuh dukungan
perangkat gadget yang memadai.



7. Wondershare Filmora

Merupakan aplikasi editing video yang mudah
digunakan bagi pemula namun memiliki fitur yang
lengkap. Anda bisa menggunakan aplikasi ini utnuk
mengedit media video pembelajaran Anda agar lebih
menarik.

. " Wondershare
Filmora

Gambar 3. 16 Contoh logo filmora

Filmora memiliki beragam template, efek
animasi serta transisi yang keren dan menarik yang bisa
digunakan secara gratis. Tampilan Filmora juga
sederhana sehingga mudah digunakan. Output video di
filmora juga sudah mendukung beragam format.
Filmora tersedia untuk versi gratis dan berbayar. Anda
bisa akses dan unduh aplikasi ini  melalui
filmora.wondershare.com.

Kelebihan:

60



1). Memiliki tampilan sederhana dan mudah digunakan;
2). Ringan dan tidak mudah crash;

3). Banyak fitur, template, dan plugin gratis;

4). Mendukung banyak format output video;

5). Tersedia tutorial video lengkap;

6). Tersedia versi mobile dengan nama Filmora Go.
Kekurangan:

1). Berbayar jika ingin mendapatkan fitur penuh;

2). Kurang fleksibel dan kustomisasi dibandingkan
premiere pro;

3). Membutuhkan spesifikasi PC/Lapotop yang bagus;
4). Template, efek, plugin, transisi, dan lainnya perlu
diunduh lagi.

3.4 Cara Penggunaan Canva

Dalam pengembangan multimedia saya disini
menggunakan canva untuk kebutuhan sehari-hari untuk
seperti membuat surat undangan, sertifikat, dan lain lain.
Saya akan memberikan tata cata menggunakan canva
seperti contoh di bawah ini:



1. Login Canva

Pergi la ke google dan ketik saja canva seperti
contoh gambar di bawah ini:

Google

canva

Aplikasi Visual unt
Canva adalah alat desain

untuk membuat kirman media sosial, presentasi,

Template gratis

Template gratis. Jelajar

Canva Gratis
car

>anva untuk Pendidikan

Situs Web

Apakah Situs web Canva be

Presentasi

Masuk ke mode Tampilan

wa.coms id_id §

uk Semua - Canva
grafis online yang dapat digunakan secara gratis. Gunakan Canva
poster, video

i ribuan template gratis yang menarik

adalah Canva versi premium yang

nar-benar gratis? Situs web Canva

Presenter dan dapatkan layar

Gambar 3. 17 Contoh mencari canva di google

)
I

Alat

Lalu klik link yang paling atas dan login
menggunakan akun google anda dan canva siap di

digunakan.
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Gambar 3. 18 Contoh tampilan awal canva

2. Cara Membuat Sertifkat Dengan Template

Ketik saja di pencarian, ketik sertifikat juara lalu
jika muncul klik saja seperti contoh gambar di bawah
ini:

an v BiEAs v EGUKaS v eee Q sertifeat juara [ =1
@ Template Canva X |
Q  cansertifikat juara Enter
Tak perlu carl llham ke

Q,  sertfikatjuara

Canva

Wujudkan ide dan karya terbalkmu dengan | Q sertifikat juaakelas
unik.
Q  sertifikatjuarakelas sd

g]

Sertifikat Penghargaan-Tanda Jasa 297+

Gambar 3. 19 Cara mencari template
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Jika sudah pilih tamplate yang di ingin kan lalu
pilih dan klik seperti contoh gambar di bawabh ini:

esan v Bisws v Edukasi v ses Q sertifikat juara o 2 &0
| @ memplatecanva x | 5 semuariter | Kategori v
T s S ¥ snnnma o===" W
N R4 = X R —2)
o o
. Putih &Biru Modere. = Putih dan Tosca Sed ' HiAREpaMcdain... | @ SertilatPurigharg
Sertifikat oleh Canvalue ertifkat oleh Fonthera ertsikat oleh brother ertikat oleh Bes Cre.

Al EE T LA S
A - o 4 4 . 4
o o

Gambar 3. 20 memilih tamplate

Lalu jika sudah memilih tamplate nya edit la kata
kata nya sesuai yang dingin kan, Kkita juga bisa
mengganti tata letak nya, font nya dan lain lain seperti
contoh di bawah ini:
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@ ® ¢

© @
SERTIFIKAT

PENGHARGAAN

o DIZBERIKAN -(EDADA. @
N Ketut Susilo

Atas Prestasinya Sebagai Peserta Dalam Acara Lomba Cerdas Cermat
Pada Tanggal 12 December 2022

SEBAGAI JUARA 1
Mengetahui Penyelenggara
Yael Amari Juliana Silvi
Kepala Sekolah Wali Kelas

Gambar 3. 21 tamplate sebelum di edit

C
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SERTIFIKAT
PENGHARGAAN
O DIBERIKAN KEPADA I@
| ANGBI

Atas Prestasinya Sebagai Peserta Dalam Acara Lomba Balap Kereta
Pada Tanggal 12 December 2024

SEBAGAI JUARA1

Mengetahui Penyelenggara

1 Am, Jul
W

Yael Amari
Kepala Sekolah

Gambar 3. 22 tamplate sesudah di edit

Seperti gambar di atas terlihat perbedaan nya

template yang belum di edit dan yang sudah di edit.

Jika ingin menyimpan hasil nya atau

ingin

mendownload nya adalah seperti contoh di bawah ini:
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+ 4l [P cetakdenganCanva (T, Bagikan

¢ Unduh
Jenis file
@ PNG (EELLEN v
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— . 1

2000 = 1414 piksel
[} Latarbelakang transparan

[ memadatkan file (kualitas lebih rendah)

Preferensi

[ ] simpan pengaturan pengunduhan

Gambar 3. 23 Contoh mengunduh file
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BAB IV
BEKERJA DENGAN CORELDRAW X7
A. Layar

Antarmuka CoreIDRAW X7 dirancang untuk
memudahkan pengguna dalam mengakses berbagai fitur
yang tersedia. Layar utama terdiri dari beberapa bagian
penting:

S ConORAN - Wikoma
[ Tooks Wintow s

=
[ u m - BE D
- 5
/A i
(B) Workspace L!
\W/

! e
[ cesanee Lit "'I
st c
0wt !
N

a2
Advanced |

e

Gambar 4.1 layar CorelDraw X7

1. Menu Bar: Terletak di bagian atas layar, berisi
menu-menu utama seperti File, Edit, View,
Layout, dan lainnya.
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2. Toolbox: Terletak di sebelah kiri layar, berisi
alat-alat yang digunakan untuk menggambar dan
mengedit objek, seperti Pick Tool, Shape Tool,
dan lainnya.

3. Property Bar: Terletak di bawah Menu Bar,
menampilkan opsi-opsi yang terkait dengan alat
yang sedang aktif.

4. Docker: Terletak di sebelah kanan layar, berisi
panel-panel yang dapat ditampilkan atau
disembunyikan sesuai kebutuhan, seperti Object
Properties, Color Palette, dan lainnya.

5. Status Bar: Terletak di bagian bawah layar,
menampilkan informasi tentang dokumen, seperti
ukuran halaman, posisi kursor, dan lainnya.

Antarmuka ini dapat disesuaikan  sesuai
kebutuhan dengan mengatur posisi dan tampilan panel-
panel yang ada, sehingga memudahkan pengguna dalam
mengakses fitur-fitur yang sering digunakan.

B. File

Menu File menyediakan berbagai opsi untuk
mengelola dokumen di CorelDRAW X7. Beberapa fitur
utama yang tersedia di menu ini antara lain:



o CorelDRAW X7 (64-Bit) - contoh eksport

Eﬂ'~ Edit View Layout Object Effects Bitmaps Text
lew... Ctri«N Field
New from Template... :
QOpen... Ctrl+0 B C
Open Recent » LB =1

va

-
=)

Ly

Close

Close All

Save... Ctrl+S
Save As... Ctrl+Shift+S
Save as Template...

ELD @3

Acquire Image »
Search Content

Import... Ctriel
Export... Ctri+E
Export For »
Send To »

o %R

Publish to PDF
Publish Page to ConceptShare...

@

Print... Ctrl«P
Print Merge »

It

Print Preview...
Collect For Oytput...

Document Properties...

YLEL

Exit AlteF4

B4 « 1010 » M [ Pagel " Page2  Page
» 2 X B

(-13.804, 41.148) 3]

Gambar 4.2 File CorelDraw X7

New: Membuat dokumen baru.

Open: Membuka file yang sudah ada, mendukung
berbagai format seperti CDR, Al, EPS, PDF, dan
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3. Save: Menyimpan dokumen yang sedang
dikerjakan.

4. Save As: Menyimpan dokumen dengan nama atau
lokasi yang berbeda.

5. Import: Mengimpor file dari format lain ke dalam
dokumen.

6. Export: Mengekspor dokumen ke berbagai format,
seperti PNG, JPG, PDF, dan lainnya.

7. Print: Mengatur dan mencetak dokumen.

Menu ini sangat penting untuk memastikan
bahwa semua pekerjaan yang dilakukan dapat disimpan
dan dikelola dengan baik.

C. View

Menu View memungkinkan pengguna untuk
mengatur tampilan dokumen di layar. Beberapa fitur
yang tersedia di menu ini antara lain:



CorelDRAW - Untitled-1*
file  Edit layout  Effets  Bitmaps  Tet
ﬁl D — l Wireframe O e

Normal
Letter ® Enhanced o (10

\ ‘ Untit Pixels
( ey i Full-screen Preview F9
“

/ Multipage View
rb Q Zoom |n Ctrl++
K’ =l Q Zoom Qut Ctrl+-
FANN

Proof Colors

Simulate Oyerprints

Rasterize Complex Effects

Page »

Grid .
Rulers Alt+Shift+R
Guidelines

1
1

Alignment Guides Alt+Shift+A

Dynamic Guides Alt+Shift+D
Snap To >
Snap Off Alt+Q

> OB O AN
<L

«/ Document Navigator
v

Scrollbars

Gambar 4.3 View CorelDraw X7




1. Zoom: Memperbesar atau memperkecil tampilan
dokumen.

2. Rulers: Menampilkan atau menyembunyikan
penggaris di sekitar area kerja.

3. Grid: Menampilkan atau menyembunyikan grid,
yang membantu dalam penyelarasan objek.

4. Guidelines: Menampilkan atau menyembunyikan
garis panduan yang bisa disesuaikan.

5. Page Sorter View: Menampilkan semua halaman
dalam dokumen secara bersamaan, memudahkan
pengaturan dan navigasi.

Dengan menu ini, pengguna dapat dengan mudah
menyesuaikan tampilan dokumen agar lebih nyaman dan
efisien dalam bekerja.

D. Edit

Menu Edit menyediakan berbagai perintah untuk
mengedit objek dan teks dalam dokumen. Beberapa fitur
utama di menu ini antara lain:



&) corelbraw - untitled-1*

File Edit ' View Layout Effects Bitmaps

CJ t\') Undo Delete ar+z | ’)
Letter : .
z !
9
'
L
K qzj Paste Ctri+v
%3 Paste in View Ctrl+Shift+Vv
[lﬁ 'I! Paste Special...

e
8
E], ifl Clone
)

Select All "
Find and Replace Ctri+F
Q4. Step and Repeat Ctrl+Shift+D

Gambar 4.4 Edit CorelDraw X7

Cut, Copy, Paste: Memotong, menyalin, dan
menempelkan objek atau teks.

Delete: Menghapus objek atau teks yang dipilih.

Undo, Redo: Membatalkan atau mengulang
tindakan terakhir.
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atau objek tertentu di dokumen.

Find and Replace: Mencari dan mengganti teks

Duplicate: Membuat salinan objek yang dipilih.

Fitur-fitur ini sangat penting untuk mengelola
dan memanipulasi konten dalam dokumen dengan cepat

dan efisien.

E. Layout

Menu Layout membantu dalam mengatur tata
letak halaman dan objek di dalam dokumen
fitur yang tersedia di menu ini antara lain:

AW - Untitled-1*

View
|doeFE
(5]

EJI
EIO
EJ/

ititled-1*

£s

0N
o

d
“
i
721
&

Layout

Effects Bitmaps Text

Insert Page...

=] Duplicate Page...

Rename Page...
Delete Page...
Go to Page...

Insert Page Number »

Page Number Settings...
Switch Page Orientation

Document Options...
Page Size...

Page Layout...

Page Background...

Border and Grommet...

Gambar 4.5 Layout CorelDraw X7

. Beberapa
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1. Page Setup: Mengatur ukuran halaman, orientasi,
dan margin.

2. Insert Page: Menambah halaman baru ke dalam
dokumen.

3. Delete Page: Menghapus halaman yang dipilih.

4. Page Background: Mengatur latar belakang
halaman, termasuk warna dan gambar.

5. Guides Setup: Mengatur dan mengelola garis
panduan untuk penyelarasan objek.

Dengan menu ini, pengguna dapat dengan mudah
mengatur dan menyesuaikan tata letak dokumen agar
sesuai dengan kebutuhan desain.

F. Object

Menu Object digunakan untuk mengelola objek
dalam dokumen. Beberapa fitur utama yang tersedia di
menu ini antara lain:



LATIHAN

wt  Objpect Effegts Bitmaps Text Jable Tgols

M Insert Barcode... %
i B8 Insert QR Code
Y | Yelidste Barcode ot
. & Insert Ney Object. [J
ATH
Symbol »
PoyerChp »
Jransformations »
Algn and Distnbute »
QOrder ’
Group »
Lock »
Shaging »
Jon Curves
¥ Object Properties AR+ Enter

¥ Object Mapager
Gambar 4.6 Object CorelDraw X7

Order: Mengatur urutan tumpukan objek, seperti
membawa ke depan atau mengirim ke belakang.

Group, Ungroup: Mengelompokkan atau
memisahkan objek yang dipilih.
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3. Convert to Curves: Mengubah bentuk objek
menjadi kurva yang dapat diedit.

4. Align and Distribute: Menyelaraskan dan
mendistribusikan objek dengan jarak yang sama.

5. Lock, Unlock: Mengunci atau membuka kunci
objek agar tidak bisa diedit atau dipindahkan.

Fitur-fitur ini sangat penting untuk memastikan
bahwa semua objek di dokumen dapat dikelola dan
dimanipulasi dengan mudah.

G. Effects

Menu Effects menawarkan berbagai efek khusus
yang dapat diterapkan pada objek untuk meningkatkan
visual desain. Beberapa efek yang tersedia di menu ini
antara lain:



Effects Bitmaps Text Table
}] ‘ﬁ‘ Flatten Effects [}

54 30 Effects Olo
n Adjust
Art Strokes
Blur
Camera
Color Transform
Contour
Correction
Creative
Custom
Distort
Noise
Sharpen

Texture

Trapsform

Artistic Media

Bevel

Blend

Contour Ctri+F9
Envelope Ctri+F7
Extrude

Lens Alt+F3
PhotoCocktail

Pointillizer

Gambar 4.7 Effect CorelDraw X7

Drop Shadow: Menambahkan bayangan di

belakang objek untuk memberikan efek kedalaman.

Contour: Membuat garis tepi di sekitar obje
dengan jarak yang dapat disesuaikan.

k
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3. Blend: Menggabungkan dua objek dengan membuat
transisi yang mulus di antara mereka.

4. Distort: Menerapkan distorsi pada objek, seperti
putaran, gelombang, atau kerut.

5. Envelope: Mengubah bentuk objek dengan
menyesuaikan titik kontrol di sekitarnya.

Dengan menggunakan efek-efek ini, pengguna
dapat memperindah dan memperkaya desain dengan
berbagai gaya visual yang menarik.

H. Bitmaps

Menu Bitmaps menyediakan alat untuk
mengelola dan mengedit gambar bitmap. Beberapa fitur
utama di menu ini antara lain:



77@@957 | Text Table Tools v

% r_j Convert to Bitmap,.. m

E] Straighten Image... o
% Remove JPEG Artifacts

[ Edit Bitmap..

Resample...
Mode .
Inflate Bitmap 4

f_“j Quick Trace

Centerline Trace »
Outline Trace »
Plug-ins »
Bitmap Mask

Gambar 4.8 Bitmaps CorelDraw X7

Convert to Bitmap: Mengubah objek vektor

menjadi gambar bitmap.

Edit Bitmap: Membuka gambar bitmap untuk

diedit menggunakan Corel PHOTO-PAINT.

Resample: Mengubah ukuran gambar bitmap

dengan menyesuaikan resolusi.
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4. Mode: Mengubah mode warna gambar, seperti
RGB, CMYK, atau grayscale.

5. Bitmap Effects: Menerapkan berbagai efek pada
gambar bitmap, seperti sharpen, blur, dan color
adjustments.

Menu ini sangat penting untuk pengolahan
gambar dan foto dalam dokumen desain.

l. Text

Menu Text memungkinkan pengguna untuk
menambahkan dan mengedit teks dalam dokumen.
Beberapa fitur utama yang tersedia di menu ini antara
lain:



1.

Gambar 4.8 Text CorelDraw X7

Text Jable Tgols Window

-

Text Properties
Tabs.

| Cglumns.

4

zE

Bullets..

Drop Cap.

Font Playground

Edit Text..

Insert Character

Insert Formatting Code

Show NOh-Printing Characters
Paragraph Text Frame

Fit Text to Path
Straighten Text

Align To Baseline
Align To Baseline Grid

Use Hyphenation

& Hyphenation Settings.

E

+ 3% B

Writing Tools

Change Case...

i Encode.
U WhatTheFont?!...

% Text Statistics.

Font List Options.

Help
Ctrl+T Sna
1
4
Ctrl+Shift+T
Ctri+F11
»
Ctrl+Shift+C
»
| po\
Alt+F12 ..bed
) tha
men
*at cc
shift+F3 - clii
also
sture
eadi

Insert Text: Menambahkan teks baru ke dalam

dokumen.

Format Text: Mengatur format teks, termasuk jenis

font, ukuran, warna, dan gaya (bold,

underline).

italic,

Paragraph Formatting: Mengatur format paragraf,
seperti perataan, indentasi, dan spasi antar baris.
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4. Fit Text to Path: Mengatur teks agar mengikuti
jalur atau bentuk objek tertentu.

5. Spell Check: Memeriksa ejaan dan tata bahasa teks
dalam dokumen.

Dengan menu ini, pengguna dapat mengelola dan
memformat teks dengan fleksibilitas yang tinggi.

J. Table

Menu Table memungkinkan pengguna untuk
membuat dan mengedit tabel dalam dokumen. Beberapa
fitur utama di menu ini antara lain:

Table Tools Window Help
Create New Table...

Insert
Select

Delete

v - - -

Distribute

Gambar 4.8 Table CorelDraw X7



1. Insert Table: Menambahkan tabel baru ke dalam
dokumen.

2. Edit Table: Mengedit tabel yang sudah ada,
termasuk menambah atau menghapus baris dan
kolom.

3. Table Format: Mengatur format tabel, seperti
border, shading, dan alignment.

4. Convert Text to Table: Mengubah teks yang
dipisahkan oleh tanda tertentu menjadi tabel.

5. Merge Cells: Menggabungkan beberapa sel
menjadi satu sel.

Fitur ini sangat berguna untuk menyusun data
secara terstruktur dan rapi dalam dokumen desain.

K. Window

Menu  Window di  CoreIDRAW X7
memungkinkan pengguna untuk mengatur tata letak dan
tampilan jendela kerja. Beberapa fitur utama yang
tersedia di menu ini antara lain:



1.

indow Help

New Window

gv
[32:22)

Refresh Window Ctri+wW

S

Close Window Ctri+F4

Close All

D Q20

Cascade

Workspace »

Dockers »
Toolbars »

Color Palettes »

® Untitled-1*

Gambar 4.8 Window CorelDraw X7

New Window: Membuka jendela baru dari
dokumen yang sama.

Cascade: Menata semua jendela dokumen yang
terbuka dalam format kaskade.

Tile: Menata semua jendela dokumen yang terbuka
berdampingan, baik secara horizontal maupun
vertikal.
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4. Dockers: Mengatur panel-panel tambahan yang
dapat ditampilkan atau disembunyikan sesuai
kebutuhan, seperti Object Properties, Color Palette,
dan lainnya.

5. Toolbars: Mengatur toolbar yang ingin ditampilkan
di layar kerja.

Menu ini  memudahkan pengguna dalam
mengelola berbagai jendela dan panel, sehingga
meningkatkan efisiensi kerja.

L. Help

Menu Help menyediakan akses ke berbagai
sumber daya bantuan yang berguna bagi pengguna
CoreIDRAW X7. Beberapa fitur utama yang tersedia di
menu ini antara lain:



1.

Ix

elp
Product Help... 8 s

Welcome Screen 0.25

JSOORSEHES [ 8

Video Tutorials... 0.25
Learn

Quick Start Guide...

User Guide...

What's New?...

Updates...

Message Settings
CorelDRAW Community
Corel Support...

Submit Ideas and Feedback...

Account Settings...

Restore Purchases...

i
o About CorelDRAW...

Gambar 4.8 Window CorelDraw X7

Help Topics: Membuka panduan pengguna yang
berisi informasi rinci tentang berbagai fitur dan alat
di CoreIDRAW X7. Pengguna dapat mencari topik
tertentu atau menelusuri daftar isi untuk menemukan
informasi yang dibutuhkan.

Hints:  Menampilkan panel petunjuk yang
memberikan tips dan informasi kontekstual
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berdasarkan alat atau fitur yang sedang digunakan.
Fitur ini sangat berguna bagi pengguna baru yang
ingin mempelajari cara menggunakan CoreIDRAW
X7 dengan lebih efektif.

Welcome Screen: Mengakses layar sambutan yang
berisi tautan cepat ke tutorial, dokumentasi, dan
sumber daya online lainnya. Layar ini juga
menampilkan proyek terbaru dan template yang
tersedia.

Product Help: Menghubungkan pengguna ke situs
web dukungan resmi CoreDRAW, di mana mereka
dapat menemukan artikel bantuan, video tutorial,
dan forum pengguna untuk mendapatkan bantuan
dari komunitas.

CorelDRAW Community: Mengarahkan pengguna
ke komunitas online di mana mereka dapat
berinteraksi dengan pengguna lain, berbagi tip dan
trik, serta mengajukan pertanyaan dan mendapatkan
jawaban.

Check for Updates: Memeriksa pembaruan
perangkat lunak untuk memastikan bahwa pengguna
memiliki versi terbaru dari CorelDRAW X7 dengan
semua perbaikan dan fitur terbaru.



7. About CoreIDRAW: Menampilkan informasi
tentang versi perangkat lunak yang sedang
digunakan, termasuk nomor versi dan informasi
lisensi.

Dengan menggunakan menu Help, pengguna
dapat dengan mudah mengakses berbagai sumber daya
yang diperlukan untuk memaksimalkan penggunaan
CoreDRAW X7 dan mengatasi masalah yang mungkin
dihadapi selama proses desain.

Dengan memahami dan menguasai berbagai
menu dan fitur dalam CorelDRAW X7, pengguna dapat
memaksimalkan kreativitas dan efisiensi dalam bekerja
dengan desain grafis. Setiap menu dan fitur dirancang
untuk memberikan fleksibilitas dan kontrol penuh atas
proses desain, sehingga memungkinkan pengguna untuk
menghasilkan karya yang profesional dan menarik.



BAB V
BEKERJA DENGAN PHOTOSHOP CS6

1. Layar

Antarmuka Adobe Photoshop CS6 dirancang
untuk memudahkan pengguna dalam mengakses
berbagai fitur dan alat yang tersedia. Layar utama terdiri
dari beberapa bagian penting:

Gambar 5.1 Window Photoshop

1. Menu Bar: Terletak di bagian atas layar, berisi
menu-menu utama seperti File, Edit, Image,
Layer, dan lainnya.
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2. Options Bar: Terletak di bawah Menu Bar,
menampilkan opsi-opsi yang terkait dengan alat
yang sedang aktif.

3. Toolbox: Terletak di sebelah kiri layar, berisi
alat-alat yang digunakan untuk menggambar,
mengedit, dan memanipulasi gambar, seperti
Move Tool, Brush Tool, dan lainnya.

4. Panels: Terletak di sebelah kanan layar, berisi
panel-panel yang dapat ditampilkan atau
disembunyikan sesuai kebutuhan, seperti Layers,
Adjustments, dan lainnya.

5. Document Window: Bagian utama layar di
mana gambar atau proyek sedang ditampilkan
dan diedit.

6. Status Bar: Terletak di bagian bawah layar,
menampilkan informasi tentang dokumen, seperti
zoom level, ukuran file, dan lainnya.

Antarmuka ini dapat disesuaikan  sesuai
kebutuhan dengan mengatur posisi dan tampilan panel-
panel yang ada, sehingga memudahkan pengguna dalam
mengakses fitur-fitur yang sering digunakan.



2. File

Menu File menyediakan berbagai opsi untuk

mengelola dokumen di Photoshop CS6. Beberapa fitur

utama yang tersedia di menu ini antara lain:

New... Ctrl+N
Open... Ctrl+0
Browse in Bridge... Alt+Ctrl+0
Open As... Alt+Shift+Ctrl+0
Open as Smart Object...

Open Recent

Close Cirl+W
Close All AltsCtrl+W
Close Others Alt+Ctrl+P
Close and Go to Bridge... Shift+Ctrl+W
Save Ctrl+5
Save As... Shift+Ctrl+S
Save a Copy... Alt+Ctrl+S
Revert F12
Export

Generate

Search Adobe Stock...

Place Embedded...

Place Linked...

Package...

Automate

Scripts

Import

File Info... Alt+Shift+Ctrl+1
Print... Cirl+P

Print One Copy Alt+Shift+Ctrl+P

Exit Ctrl+Q

File Edit Image Layer Type Select Filter

»

Gambar 5.2 File Photoshop
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1. New: Membuat dokumen baru.

2. Open: Membuka file yang sudah ada, mendukung
berbagai format seperti PSD, JPEG, PNG, dan
lainnya.

3. Save: Menyimpan dokumen yang sedang
dikerjakan.

4. Save As: Menyimpan dokumen dengan nama atau
lokasi yang berbeda.

5. Import: Mengimpor file dari format lain ke dalam
dokumen.

6. Export: Mengekspor dokumen ke berbagai format,
seperti JPEG, PNG, TIFF, dan lainnya.

7. Print: Mengatur dan mencetak dokumen.
8. File Info: Menambahkan metadata ke dalam file.

Menu ini sangat penting untuk memastikan
bahwa semua pekerjaan yang dilakukan dapat disimpan
dan dikelola dengan baik.

3. Edit

Menu Edit menyediakan berbagai perintah untuk
mengedit gambar dan teks dalam dokumen. Beberapa
fitur utama di menu ini antara lain:



Edit Image Layer Type Select Filter 3D

opy
Copy Merged Shift+Cirl+<
Paste Ctrlsv
Paste Special 4
Search Ctri+F

Check Spelling...
Find and Replace Text.

Fill... Shift+F5

e Alt+Shift+Ctrl+C

Purge 3

Adobe PDF Presets...
Presets 3
Remote Connections...

Color Settings. Shift+Ctri+K
Assign Profile..
Convert to Profile..

Keyboard Shortcuts..  Alt+Shift+Ctrl+K

Alt+ShiftsCtrl+«M
>

Gambar 5.3 Edit Photoshop

Undo, Redo: Membatalkan atau mengulang
tindakan terakhir.

Cut, Copy, Paste: Memotong, menyalin, dan
menempelkan objek atau teks.

Fill: Mengisi area yang dipilih dengan warna atau
pola.
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4. Stroke: Menambahkan garis tepi pada area yang
dipilih.

5. Free Transform: Mengubah ukuran, memutar, dan
mendistorsi objek atau area yang dipilih.

6. Puppet Warp: Menyesuaikan bentuk objek dengan
menempatkan titik kontrol pada bagian-bagian
tertentu.

Fitur-fitur ini sangat penting untuk mengelola
dan memanipulasi konten dalam dokumen dengan cepat
dan efisien.

4. Image

Menu Image memungkinkan pengguna untuk
mengatur dan memodifikasi gambar. Beberapa fitur
utama yang tersedia di menu ini antara lain:



Image Layer Type Select Filter 3[

Mode 4
Adjustments »

Auto Tone Shift+Ctrl+L
Auto Contrast  Alt+Shift+Ctrl+L
Auto Color Shift+Ctrl+B

Image Size... Alt=Ctrl+]
Canvas Size... Alt+Crrl+C
Image Rotation »
Crop

Trim...

Reveal A

Duplicate...
Apply Image...
Calculations...

Variables 4
Apply Data Set...

Trap...

Analysis »

Gambar 5.4 Image Photoshop

Adjustments:  Menyediakan  berbagai  opsi
penyesuaian warna dan tonalitas gambar, seperti
Brightness/Contrast, Levels, Curves, dan
Hue/Saturation.

Image Size: Mengubah ukuran gambar dengan
menyesuaikan resolusi dan dimensi.

Canvas Size: Mengubah ukuran kanvas tanpa
mengubah ukuran gambar.

Image Rotation: Memutar gambar dengan sudut
tertentu.
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5. Crop: Memotong gambar untuk menghilangkan
bagian yang tidak diinginkan.

6. Trim: Menghapus area kosong di sekitar gambar.

Menu ini sangat berguna untuk mengatur dan
memodifikasi gambar sesuai dengan kebutuhan desain.

5. Layer

Menu Layer digunakan untuk mengelola lapisan
(layer) dalam dokumen. Beberapa fitur utama yang
tersedia di menu ini antara lain:



Layer Type Select Filter 3D View

New »
Copy CSS

Copy SVG

Duplicate Layer.

Delete 4

Quick Export as PNG  Shift+Ctrl+*

Export As... Alt+Shift+Crl+"
Rename Layer...

Layer Style 4
Smart Filter 4
New Fill Layer »
New Adjustment Layer 4
Layer Content Options...

Layer Mask 13
Vector Mask 4

Create Clipping Mask  Alt+Ctrl+G
Mask All Objects

Smart Objects 4
Video Layers »
Rasterize »

New Layer Based Slice

Group Layers Ctrl+G
Ungroup Layers Shift+Ctrl+G
Hide Layers Ctrl+,
Arrange 3
Combine Shapes 3
Align 4
Distribute 3
Lock Layers... Ctrl+/
Link Layers

Select Linked Layers

Merge Layers Ctrl+E
Merge Visible Shift+Ctrl+E
Flatten Image

Matting 3

Gambar 5.5 Layer Photoshop

New: Membuat layer baru.

Duplicate Layer: Membuat salinan layer yang

dipilih,

Delete: Menghapus layer yang dipilih.
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4. Layer Styles: Menerapkan efek khusus pada
layer, seperti Drop Shadow, Bevel and Emboss,
dan Stroke.

5. Adjustment Layers: Menambahkan layer
penyesuaian untuk mengatur warna dan tonalitas
tanpa merusak gambar asli.

6. Layer Mask: Menyembunyikan atau
menampilkan  bagian dari layer dengan
menggunakan masker.

7. Smart Objects: Mengubah layer menjadi objek
pintar yang dapat diedit tanpa kehilangan
kualitas.

Fitur-fitur ini sangat penting untuk mengatur dan
memanipulasi layer dalam dokumen dengan fleksibilitas

yang tinggi.
6. Type

Menu Type memungkinkan pengguna untuk
menambahkan dan mengedit teks dalam dokumen.
Beberapa fitur utama yang tersedia di menu ini antara
lain:



Type Select Filter 3D View
More from Adobe Fonts...

Panels 4
Anti-Alias 4
Orientation 4
OpenType 4

Extrude to 3D

Create Work Path
Convert to Shape

Rasterize Type Layer
Convert Text Shape Type

Warp Text...

Match Font...

Font Preview Size 4
Language Options 4
Update All Text Layers

Manage Missing Fonts
Paste Lorem Ipsum

Load Default Type Styles
Save Default Type Styles

Gambar 5.6 Type Photoshop

1. Warp Text: Menerapkan efek warp pada teks
untuk mengubah bentuknya.

2. Paragraph Panel: Mengatur format paragraf,
seperti perataan, indentasi, dan spasi antar baris.

Dengan menu ini, pengguna dapat mengelola dan
memformat teks dengan fleksibilitas yang tinggi.
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7. Select

Menu Select menyediakan berbagai perintah
untuk memilih dan memanipulasi area dalam dokumen.
Beberapa fitur utama di menu ini antara lain:

Select Filter 3D View Plugins

All Ctrl+A
Deselect Ctrl+D
Reselect Shift+Ctrl+D
Inverse Shift+Ctrl+I
All Layers Alt+Ctrl+A

Deselect Layers
Find Layers  Alt+Shift+Ctrl+F
Isclate Layers

Color Range...
Focus Area...

Subject
Sky

Select and Mask... Alt+Ctrl+R
Modify 4

Grow
Similar
Transform Selection

Edit in Quick Mask Mode

Load Selection...
Save Selection...

New 3D Extrusion

Gambar 5.7 Select Photoshop

102



1. All: Memilih seluruh area dalam dokumen.

2. Deselect: Menghapus seleksi yang aktif.

3. Reselect: Memilih kembali area yang terakhir
dipilih.

4. Inverse: Membalikkan seleksi, memilih area yang

tidak dipilih sebelumnya.

5. Modify: Mengubah seleksi dengan opsi seperti
expand, contract, feather, dan smooth.

6. Color Range: Memilih area berdasarkan warna
yang serupa dalam gambar.

Fitur-fitur ini sangat berguna untuk mengelola dan
memanipulasi seleksi dalam dokumen dengan cepat dan
efisien.

8. Filter

Menu Filter menawarkan berbagai efek khusus
yang dapat diterapkan pada gambar untuk meningkatkan
visual desain. Beberapa filter yang tersedia di menu ini
antara lain:



Filter 3D View Plugins Window Help

Last Filter Alt+Ctrl+F
Convert for Smart Filters
Neural Filters...

Filter Gallery...

Adaptive Wide Angle.. Alt+Shift+Ctrl+A
Camera Raw Filter... Shift+Ctrl+4
Lens Correction... Shift+Ctrl+R
Liquify... Shift+Ctrl+X
Vanishing Point... Alt+Ctrl+V

3D

Blur
Blur Gallery
Distort
Moise
Pixelate
Render
Sharpen
Stylize
Video
Other

v Y Y YY Y YYTETYY

Gambar 5.8 Filter Photoshop

Blur: Menerapkan efek blur pada gambar untuk
mengurangi detail.

Sharpen: Meningkatkan ketajaman gambar.

Distort: Menerapkan distorsi pada gambar,
seperti Ripple, Twirl, dan Spherize.

Noise: Menambahkan atau mengurangi noise
pada gambar.
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5. Render: Menerapkan efek render, seperti
Lighting Effects dan Lens Flare.

6. Other: Berbagai filter tambahan seperti High
Pass dan Custom.

Dengan menggunakan filter-filter ini, pengguna
dapat memperindah dan memperkaya desain dengan
berbagai gaya visual yang menarik.

9.3D

Menu 3D memungkinkan pengguna untuk
membuat dan mengedit objek tiga dimensi dalam
dokumen. Beberapa fitur utama yang tersedia di menu
ini antara lain:



New 3D Layer from File...

Merge 3D Layers

Export 3D Layer...

Spherical Panorama 13

Get More Content...

New 3D Extrusion from Selected Layer
New 3D Extrusion from Selected Path
New 3D Extrusion from Current Selection
New Mesh from Layer »

Group Objects

Group All Objects in Scene
Move Object to Ground Plane
Pack Objects on Ground Plane

New Tiled Painting from Layer
Generate UVs...

Paint Falloff.
Paint System 4
Paint on Target Texture 4

Select Paintable Areas
Create Painting Overlay 4

Split Extrusion

Apply Cross Section to Scene
Unify Scene for 3D Printing
Simplify Mesh(es)...

Make Work Path from 3D Layer

Render 3D Layer Alt+Shift+Ctrl+R
Render Document To File...
Sketch With Current Brush

3D Print Settings.
3D Print...

Gambar 5.9 3D Photoshop

New 3D Layer from File: Membuat layer 3D baru
dari file yang ada.

New Mesh from Layer: Mengubah layer menjadi
mesh 3D.

3D Extrusion: Membuat objek 3D dari teks atau
bentuk vektor.
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4. 3D Postcard: Mengubah layer menjadi kartu pos
3D.

5. Render Settings: Mengatur pengaturan render
untuk objek 3D.

6. 3D Print: Mempersiapkan objek 3D untuk dicetak
dengan printer 3D.

Menu ini memberikan fleksibilitas bagi pengguna untuk
menciptakan dan mengedit objek tiga dimensi dalam
desain mereka.

10. View

Menu View memungkinkan pengguna untuk mengatur
tampilan dokumen di layar. Beberapa fitur yang tersedia
di menu ini antara lain:



View Plugins Window Help

Proof Setup
Proof Colors

Ctrl+Y

Gamut Warning  Shift+Ctrl+Y

Pixel Aspect Ratio

Pixel Aspect Ratio Correction
32-bit Preview Options...

Zoom In
Zoom Qut
Fit on Screen

Ctrl++
Ctrl+-
Ctrl+0

Fit Layer(s) on Screen

Fit Artboard on Screen

100%

200%

Print Size
Actual Size

Flip Horizontal
Pattern Preview

Screen Mode

v Extras
Show

Rulers

v Snap
Snap To

Guides

Lock Slices
Clear Slices

Ctrl+1

Ctrl+H

Ctrl+R

Shift+Ctrl+;

>

>

>

3

»

Gambar 5.10 View Photoshop

Zoom In/Out: Memperbesar atau memperkecil

tampilan dokumen.

Fit on Screen: Menyesuaikan tampilan dokumen

agar seluruhnya terlihat di layar.
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3. Actual Pixels: Menampilkan gambar pada
ukuran sebenarnya (100%).

4. Rulers: Menampilkan atau menyembunyikan
penggaris di sekitar area kerja.

5. Guides: Menampilkan atau menyembunyikan
garis panduan.

6. Grid: Menampilkan atau menyembunyikan grid,
yang membantu dalam penyelarasan objek.

7. Snap To: Mengatur objek agar otomatis
menempel pada penggaris, grid, atau panduan
lainnya.

Dengan menu ini, pengguna dapat dengan mudah
menyesuaikan tampilan dokumen agar lebih nyaman dan
efisien dalam bekerja.

11. Plugins

Menu Plugins menyediakan akses ke berbagai plugin
pihak ketiga yang dapat diinstal untuk menambahkan
fungsionalitas tambahan ke Photoshop CS6.



Plugins  Window He

Plugins Panel

Substance 3D P

Gambar 5.11 Plugins Photoshop

Menu ini memungkinkan pengguna untuk memperluas
kemampuan Photoshop CS6 dengan menambahkan alat
dan fitur tambahan yang tidak termasuk dalam versi
standar.

12. Window

Menu Window di Photoshop CS6 memungkinkan
pengguna untuk mengatur tata letak dan tampilan
jendela kerja. Beberapa fitur utama yang tersedia di
menu ini antara lain:
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<<

<

Arrange >
Workspace »>

Find Extensions on Exchanage (legacy)...
Extensions (legacy) >

3D

Actions Alt+F9
Adjustments

Brush Settinas F5
Brushes

Channels

Character

Character Styles

Clone Source

Color F6
Content Credentials (Beta)

Glyphs

Gradients

Histogram

History

Info F8
Layer Comps

Layvers F7
Libraries

Measurement Log
Modifier Keys
MNavigator

Motes
Paragraph
Paragraph Styles
Paths

Patterns
Properties
Shapes

Styles

Swatches
Timeline

Tool Presets

Options
Tools

1 Untitled-1

Gambar 5.12 Window Photoshop
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1. Arrange: Menata semua jendela dokumen yang
terbuka dalam berbagai format seperti cascade, tile,
dan float in window.

2. Workspace: Memilih atau membuat workspace
khusus yang sesuai dengan kebutuhan pengguna,
seperti Photography, Painting, atau Motion.

3. Panels: Menampilkan atau menyembunyikan panel-
panel yang digunakan untuk mengedit dan
mengelola dokumen, seperti Layers, History,
Adjustments, dan lainnya.

4. New Window for: Membuka jendela baru dari
dokumen yang sama, memungkinkan pengguna
untuk melihat atau mengedit dokumen dari sudut
pandang yang berbeda.

5. Close: Menutup jendela dokumen yang sedang
aktif.

6. Close All: Menutup semua jendela dokumen yang
terbuka.

Menu ini memudahkan pengguna dalam mengelola
berbagai jendela dan panel, sehingga meningkatkan
efisiensi kerja.



13. Help

Menu Help menyediakan akses ke berbagai sumber daya
bantuan yang berguna bagi pengguna Photoshop CS6.
Beberapa fitur utama yang tersedia di menu ini antara
lain:

Photoshop Help...
Hands-on Tutorials...
What's New...

About Photoshop...

About Plugins »

System Info...
GPU Compatibility...

Manage My Account...
Sign In...
Updates...

Gambar 5.13 Help Photoshop

1. Photoshop Help: Membuka panduan pengguna
yang berisi informasi rinci tentang berbagai fitur
dan alat di Photoshop CS6. Pengguna dapat mencari
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topik tertentu atau menelusuri daftar isi untuk
menemukan informasi yang dibutuhkan.

2. Support Center: Menghubungkan pengguna ke
situs web dukungan resmi Adobe, di mana mereka
dapat menemukan artikel bantuan, video tutorial,
dan forum pengguna untuk mendapatkan bantuan
dari komunitas.

3. System Info: Menampilkan informasi sistem yang
berguna untuk pemecahan masalah, seperti versi
perangkat lunak, spesifikasi komputer, dan plugin
yang terinstal.

4. Updates: Memeriksa pembaruan perangkat lunak
untuk memastikan bahwa pengguna memiliki versi
terbaru dari  Photoshop CS6 dengan semua
perbaikan dan fitur terbaru.

5. About Photoshop: Menampilkan informasi tentang
versi perangkat lunak yang sedang digunakan,
termasuk nomor versi dan informasi lisensi.

Dengan menggunakan menu Help, pengguna dapat
dengan mudah mengakses berbagai sumber daya yang
diperlukan  untuk  memaksimalkan  penggunaan
Photoshop CS6 dan mengatasi masalah yang mungkin
dihadapi selama proses desain.

Kesimpulan



Dengan memahami dan menguasai berbagai menu dan
fitur dalam Adobe Photoshop CS6, pengguna dapat
memaksimalkan kreativitas dan efisiensi dalam bekerja
dengan desain grafis. Setiap menu dan fitur dirancang
untuk memberikan fleksibilitas dan kontrol penuh atas
proses desain, sehingga memungkinkan pengguna untuk
menghasilkan karya yang profesional dan menarik.



BAB VI

MEMBUAT OBJEK SEDERHANA DI
COLERDRAW
Memberi Efek Pada Objek
a. Untuk memberi efek pada objek di
CoreIDRAW, Anda bisa menggunakan
berbagai fitur dan alat yang tersedia.
Berikut adalah beberapa langkah dasar

untuk menambahkan efek pada objek:

no

Menggunakan Efek Transparansi:
a. Pilih objek.

e e -
- AEES Fet o @ WHT e M EES S e O Fuw -
T ¢ Je

SHO mmp e

s
A A " “
L - -

il
Gambar 5.1 Efek 1

b. Di toolbar, pilih "Transparency Tool".
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Gambar 5.2 Efek 2

c. Seret di sepanjang objek  untuk

menambahkan transparansi.

D comvraw
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Gambar 5.3 Efek 3
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3. Menggunakan Efek Bayangan:
a. Pilih objek.
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Gambar 5.4 Efek 4

b. Di toolbar, pilih "Drop Shadow Tool".
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Gambar 5.5 Efek 5
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c. Kilik dan seret dari objek untuk membuat

bayangan.
D cordbma - umiived
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Gambar 5.6 Efek 6

4. Menggunakan Efek Contour:
a. Pilih objek.
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Gambar 5.7 Efek 7

b. Di toolbar, pilih "Contour Tool".

D corelnRaw - Uniitied:
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Gambar 5.8 Efek 8
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c. Klik dan seret untuk menambahkan

kontur di sekitar objek.

N P .
FR-aBFs FREmy O Q B F = L T E e r O s -
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Gambar 5.8 Efek 8

5. Menggunakan Efek Distort:
a. Pilih objek.

Oh-@EEA R B 5 -C- 0 HHT m M SE " B orer s & B -
o tm 4
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Gambar 5.9 Efek 9
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b. Di toolbar, pilih "Distort Tool".

e B T e b gk ek
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Gambar 5.10 Efek 10

c. Pilih jenis distorsi (misalnya, "Push and

Pull", "Zipper", "Twister™).
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Gambar 5.11 Efek 11

d. Sesuaikan distorsi

kontrol pada objek.
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Gambar 5.12 Efek 12

menyeret
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6. Menggunakan Efek 3D:
a. Pilih objek.

D coernus
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Gambar 5.13 Efek 13

b. Di toolbar, pilih "Extrude".

s pmap W e e s b
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Gambar 5.14 Efek 14
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c. Sesuaikan distorsi dengan menyeret

kontrol pada objek.

THBRS YN O O WWE (s WL S e @ e
-+ iﬁj xam oy |- # widdnote @ B RIS B

K 4]

Gambar 5.15 Efek 15

Dengan menggunakan langkah-langkah di atas, Anda
bisa memberikan berbagai efek menarik pada objek
di CoreIDRAW. Pastikan untuk bereksperimen
dengan berbagai efek dan pengaturan untuk

mendapatkan hasil yang diinginkan.
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2. Memberi Warna Pada Objek
Untuk memberi warna pada objek di CoreIDRAW,
Anda bisa mengikuti langkah-langkah berikut:
1. Menggunakan Color Palette:
a. Pilih objek.

TR
RO S MEEE e 00

Gambar 5.16 Warna 1

b. Setelah objek dipilih, klik warna yang
diinginkan pada Color Palette yang

biasanya terletak di sisi kanan layar.
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Gambar 5.17 Warna 2

Warna akan langsung diterapkan pada
objek yang dipilih.
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Gambar 5.18 Warna 3




2. Menggunakan Fill Tool:
a. Pilih objek.

T T Ow o . a = O;._:;;' JE
-
Gambar 5.18 Warna 3

b. Di toolbar, pilih "Fill Tool.
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Gambar 5.19 Warna 4

c. Klik pada objek yang dipilih untuk
membuka dialog Fill.

d. Pilih jenis fill yang diinginkan (Solid,
Fountain,  Pattern,  Texture, atau
PostScript).
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Gambar 5.20 Warna 5

e. Atur warna sesuai keinginan dan Kklik

"OK" untuk menerapkan.

CorelDRAW - Uniitled-1*
Ele  Edit  yiew laoul Effeds  Eimaps  Tet Table Tools  Window  elp

Fr-aBEoS F.&mr 5 O DIME [ |- W M B oo - O F s -
NN AEE = % &
& [HIEEEEE =g :
tw, RGH palette -l
s w
i) |
& Red
& =
A &5
E‘ #0000
o )
@
3
3
A
%
"
L]
8
Gambar 5.21 Warna 6
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3. Menggunakan Eyedropper Tool:
a. Pilih objek.
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Gambar 5.22 Warna 7

b. Di toolbar, pilih "Eyedropper Tool".
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Gambar 5.23 Warna 8

Klik pada warna yang ingin diambil dari
objek lain atau area di dalam

CorelDRAW.

Gambar 5.24 Warna 9
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d. Setelah warna diambil, klik objek yang

ingin diwarnai dengan warna tersebut.
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Gambar 5.25 Warna 10

4. Menggunakan Object Properties Docker:
a. Pilih objek.
b. Buka Docker "Object Properties"”
(biasanya di sisi kanan layar).
c. Pada bagian Fill, pilih jenis fill dan warna
yang diinginkan.
Dengan langkah-langkah tersebut, Anda dapat
dengan mudah memberi warna pada objek di
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CoreIDRAW 2024. Pastikan untuk bereksperimen
dengan berbagai jenis fill dan warna untuk

mendapatkan hasil yang optimal.

3. Memberi Tulisan Pada Objek

Untuk memberi tulisan pada objek di CoreDRAW
2024, Anda bisa mengikuti langkah-langkah berikut:

1. Pilih Text Tool:

a. Di toolbar, pilih "Text Tool" (ikon huruf
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Gambar 5.25 Text 1
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2. Menambahkan Teks:

a. Klik di area kerja atau pada objek di
mana Anda ingin menambahkan teks.

b. Ketik teks yang Anda inginkan.
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Gambar 5.26 Text 2

3. Mengatur Format Teks:

a. Setelah teks ditambahkan, Anda bisa
mengubah formatnya seperti font, ukuran,
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warna, dan gaya menggunakan toolbar di
atas atau "Text Properties™ docker.

O '99 SPEER REFRIR V...
() VARSITY TEAM i

Belajar

A

A Belajar
Gambar 5.27 Text 3
4. Memposisikan Teks pada Objek:

a. Pilih teks yang telah Anda buat.

b. Seret teks ke lokasi yang diinginkan pada
objek atau di area kerja.
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Gambar 5.28 Text 4

5. Menggunakan Fit Text to Path:

a. Pilih teks dan objek (misalnya, lingkaran
atau bentuk lain).

137



D corvonsn - vrares 1+
Be [ ger lwwt S e T M o geam gen
CB-dBBo "Rk - @ WM == S W EE T R swn - G Flaee -

Blam  (fim mleom [PWERDBIRLDE e )
R

t

’

')

P

s

L. " . - .
] TN

o] .

E Belajar ' "
2

3 N

A . . .
[

[

"

5

Gambar 5.29 Text 5

b. Pergi ke menu "Text" > "Fit Text to
Path".
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Gambar 5.30 Text 6

c. Teks akan mengikuti kontur objek yang
dipilih.
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Gambar 5.31 Text 7
6. Mengubah Warna Teks:

a. Pilih teks.
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Gambar 5.32 Text 8

b. Di Color Palette, klik warna yang
diinginkan untuk mengubah warna teks.
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Gambar 5.33 Text 9
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7. Menggunakan Paragraph Text:
a. Pilih "Text Tool".

b. Klik dan seret untuk membuat kotak teks.

Gambar 5.34 Text 10
c. Ketik teks Anda dalam kotak tersebut.
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Gambar 5.35 Text 11
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d. Anda bisa mengatur paragraf, spasi, dan
perataan teks dengan lebih detail.

8. Mengatur Efek pada Teks:

a. Setelah menambahkan teks, Anda juga
bisa  menambahkan  efek  seperti
bayangan, kontur, dan transparansi
menggunakan alat yang tersedia di
toolbar atau menu "Effects".

Dengan langkah-langkah tersebut, Anda bisa dengan
mudah menambahkan dan mengatur tulisan pada objek
di CoreIDRAW 2024. Bereksperimen dengan berbagai
alat dan pengaturan dapat membantu Anda
mendapatkan  hasil  desain  yang  diinginkan



BAB VII

MEMBUAT OBJEK SEDERHANA PADA
PHOTOSHOP
A. Memberi Efek Pada Objek

Memberi efek pada objek di Photoshop adalah
proses di mana Anda menerapkan berbagai perubahan
visual  untuk  meningkatkan,  mengubah, atau
memperindah tampilan objek dalam gambar atau desain
Anda. Photoshop menyediakan banyak alat dan fitur
yang memungkinkan Anda menambahkan efek dari yang
sederhana hingga yang kompleks, yang bisa sangat
meningkatkan kualitas dan daya tarik visual dari karya
Anda. Berikut adalah penjelasan detail tentang berbagai
teknik dan metode untuk memberi efek pada objek di
Photoshop:

1. Layer Styles (Gaya Lapisan)

Layer Styles adalah fitur di Photoshop yang
memungkinkan Anda menambahkan berbagai efek
seperti bayangan, cahaya, emboss, dan lainnya pada
suatu layer. Efek ini dapat diterapkan tanpa merusak

gambar asli dan bisa diubah atau dihapus kapan saja.



Jenis-Jenis Layer Styles:
a. Drop Shadow (Bayangan Jatuh):

o Digunakan untuk menambahkan
bayangan di belakang objek, memberikan
efek tiga dimensi.

o Langkah-langkah:

= KIlik kanan pada layer objek dan
pilih Blending Options.

= Centang kotak Drop Shadow dan
sesuaikan parameter seperti jarak,
sebaran, dan ukuran bayangan
untuk mendapatkan efek yang
diinginkan.

b. Inner Shadow (Bayangan Dalam):

o Menambahkan bayangan di dalam tepi
objek, memberikan kesan kedalaman.

o Langkah-langkah:

= Pilih Inner Shadow dari Blending
Options dan sesuaikan parameter
untuk menambahkan bayangan di

dalam tepi objek.



c. Outer Glow dan Inner Glow:

o Outer Glow menambahkan efek cahaya
di luar tepi objek.

o Inner Glow menambahkan efek cahaya
di dalam tepi objek.

o Langkah-langkah:

= Pilih efek yang diinginkan dan
sesuaikan warna, opacity, dan
ukuran untuk mencapai efek yang
diinginkan.
d. Bevel and Emboss (Garis dan Tekstur):

o Memberikan efek tiga dimensi dengan
menambahkan highlight dan bayangan
pada tepi objek.

o Langkah-langkah:

= Pilih Bevel and Emboss dan
sesuaikan  parameter  seperti
kedalaman, arah cahaya, dan
ukuran untuk mendapatkan efek
yang realistis.

e. Gradient Overlay (Lapisan Gradasi):



o Menambahkan gradasi warna pada objek.
o Langkah-langkah:
= Pilih Gradient Overlay dan atur
warna, gaya, dan sudut gradasi
sesuai kebutuhan.
2. Filter
Filter di Photoshop adalah cara untuk menerapkan
efek pada gambar atau objek yang dapat mengubah
tampilan secara dramatis. Filter dapat digunakan untuk
menambahkan tekstur, distorsi, blur, dan berbagai efek
artistik.
Jenis-Jenis Filter:
e Gaussian Blur (Kabur Gaussian):
o Menambahkan efek kabur yang halus
pada objek.
o Langkah-langkah:
= Pilih Filter > Blur > Gaussian
Blur.
= Sesuaikan radius untuk
menambahkan efek kabur pada
objek.



Motion Blur (Kabur Gerak):

o Memberikan efek gerakan pada objek,
menciptakan kesan kecepatan.

o Langkah-langkah:

= Pilih Filter > Blur > Motion Blur.
= Atur sudut dan jarak untuk
menciptakan efek gerakan pada

objek.

Sharpen (Pertajam):

o Meningkatkan ketajaman detail pada
objek.

o Langkah-langkah:

= Pilih Filter > Sharpen untuk
meningkatkan ketajaman gambar.
Liquify:

o Mengubah bentuk objek dengan menarik,
mendorong, memutar, dan membentuk
kembali.

o Langkah-langkah:



= Pilih Filter > Liquify dan gunakan
alat yang  tersedia  untuk
mendistorsi objek sesuai
keinginan.
3. Adjustment Layers (Lapisan Penyesuaian)
Adjustment Layers memungkinkan Anda untuk
mengubah warna dan nada objek tanpa merusak gambar
asli. Ini adalah cara yang sangat fleksibel untuk
mengedit gambar karena Anda dapat mengubah
pengaturan kapan saja tanpa mengubah piksel asli.
Jenis-Jenis Adjustment Layers:
e Brightness/Contrast (Kecerahan/Kontras):
o Mengubah kecerahan dan kontras objek.
o Langkah-langkah:
= Tambahkan Brightness/Contrast
dari menu Adjustment Layers dan
sesuaikan slider untuk mengubah
kecerahan dan kontras objek.
e Hue/Saturation:
o Mengubah warna dan saturasi objek.
o Langkah-langkah:



= Tambahkan Hue/Saturation dan
sesuaikan slider untuk mengubah
warna dan saturasi objek.
e Curves (Kurva):
o Mengubah tonal range dan kontras objek.
o Langkah-langkah:
= Pilih Curves dari Adjustment
Layers dan sesuaikan kurva untuk
mengubah tonal range dan kontras
objek.
4. Smart Objects dan Smart Filters
Smart Objects memungkinkan Anda menerapkan
Smart Filters yang dapat diedit kapan saja. Ini
memberikan fleksibilitas tambahan karena Anda dapat
menyesuaikan atau menghapus filter tanpa merusak
gambar asli.
Langkah-Langkah Menggunakan Smart Objects dan
Smart Filters:
e Smart Objects:
o KiIik kanan pada layer objek dan pilih

Convert to Smart Object.



e Smart Filters:

(¢]

Setelah mengonversi ke Smart Object,
terapkan filter seperti biasa. Smart Filters
memungkinkan Anda untuk mengubah
pengaturan filter kapan saja tanpa

merusak gambar asli.

5. Blend Modes (Mode Campuran)
Blend Modes menentukan bagaimana warna pada

layer yang dipilih berinteraksi dengan warna di layer di

bawahnya.

Ini bisa digunakan untuk menciptakan

berbagai efek visual yang menarik.

Jenis-Jenis Blend Modes:

o Multiply:

o

Menggelapkan gambar dengan
mengalikan warna dasar dengan warna
campuran.

Contoh Penggunaan: Menambahkan

bayangan atau menciptakan efek gelap.



e Screen:

(¢]

Mencerahkan gambar dengan mengalikan
kebalikan dari warna dasar dan warna
campuran.

Contoh  Penggunaan: Mencerahkan

gambar atau menciptakan efek cahaya.

e Overlay:

(0]

Menggabungkan efek Multiply dan
Screen, tergantung pada warna dasar.
Contoh  Penggunaan: Meningkatkan

kontras dan memperkaya warna gambar.

6. Clipping Masks

Clipping Masks digunakan untuk membatasi efek

atau penyesuaian hanya pada layer tertentu. Ini sangat
berguna ketika Anda ingin mengaplikasikan penyesuaian
hanya pada satu objek tanpa mempengaruhi objek lain.

Cara Membuat Clipping Mask:

o Tempatkan layer yang ingin Anda gunakan

sebagai Clipping Mask di atas layer objek.

o Kiik kanan pada layer tersebut dan pilih Create

Clipping Mask.



7. Penambahan Tekstur
Menambahkan  tekstur pada objek dapat
memberikan kesan realistis atau artistik. Photoshop
menyediakan berbagai cara untuk menambahkan tekstur,
termasuk penggunaan gambar tekstur, filter, dan pattern.
Langkah-Langkah Menambahkan Tekstur:
e Menggunakan Gambar Tekstur:
o Impor gambar tekstur ke dalam proyek
Anda.
o Tempatkan gambar tekstur di atas layer
objek.
o Atur blending mode dan opacity untuk
menggabungkan tekstur dengan objek.
e Menggunakan Filter:
o Pilih Filter > Texture dan pilih jenis
tekstur yang diinginkan.
o Sesuaikan pengaturan untuk mencapai
efek yang diinginkan.
e Menggunakan Pattern:
o Pilih Layer > New Fill Layer > Pattern.



o Pilih pola dari library dan sesuaikan
pengaturan untuk menerapkan tekstur.
8. Penggunaan Masking
Masking adalah teknik yang sangat berguna untuk
mengendalikan bagian mana dari layer yang terlihat.
Dengan masking, Anda dapat menyembunyikan atau
menampilkan bagian tertentu dari layer tanpa
menghapusnya secara permanen.
Jenis-Jenis Masking:
o Layer Mask:
o Digunakan untuk menyembunyikan atau
menampilkan bagian dari layer.
o Langkah-langkah:
= Pilih layer yang ingin Anda mask.
= Klik ikon Add Layer Mask di
panel Layers.
= Gunakan Brush Tool untuk
melukis pada mask. Warna hitam
menyembunyikan bagian layer,
sementara warna putih

menampilkan bagian layer.



e Clipping Mask:
o Membatasi visibilitas layer berdasarkan
konten dari layer di bawahnya.
o Langkah-langkah:
= Tempatkan layer yang ingin Anda
gunakan sebagai Clipping Mask di
atas layer objek.
= KiIik kanan pada layer tersebut
dan pilih Create Clipping Mask.
Memberi efek pada objek di Photoshop adalah
proses yang melibatkan berbagai teknik dan alat yang
memungkinkan  Anda untuk meningkatkan atau
mengubah tampilan visual objek dalam gambar atau
desain. Dengan memahami dan menguasai berbagai
teknik ini, Anda dapat menciptakan karya yang menarik,
profesional, dan sesuai dengan visi kreatif Anda.

B. Memberi Warna Pada Objek
Memberi warna pada objek di Photoshop adalah
proses penting dalam pengeditan gambar dan desain

grafis. Photoshop menyediakan berbagai alat dan teknik



yang memungkinkan Anda untuk memberi warna pada
objek dengan cara yang tepat dan efektif. Berikut adalah
penjelasan lengkap tentang berbagai metode untuk
memberi warna pada objek di Photoshop:

1. Menggunakan Alat Brush (Kuasa)

Alat Brush adalah salah satu alat paling dasar di
Photoshop yang memungkinkan Anda melukis langsung
pada objek dengan warna yang Anda pilih. Ini sering
digunakan untuk pewarnaan yang lebih bebas dan
artistik.

Langkah-langkah:

e Pilih alat Brush dari toolbar (tekan B sebagai
pintasan keyboard).

o Pilih warna dari Color Picker yang ada di bagian
bawah toolbar atau di panel Colors.

e Atur ukuran dan Kkekerasan kuas sesuai
kebutuhan menggunakan opsi di bagian atas
layar atau dengan mengklik kanan di kanvas

kerja.



Mulailah melukis pada objek yang diinginkan
dengan mengklik dan menyeret kuas di atas area

yang ingin diwarnai.

2. Menggunakan Layer Fill atau Adjustment

Layer Fill atau Adjustment memungkinkan Anda

mengubah warna suatu objek tanpa merusak gambar asli.

Teknik ini sangat berguna untuk perubahan warna yang

lebih presisi dan non-destruktif.

Hue/Saturation:

Pilih objek yang akan diwarnai menggunakan
alat seleksi seperti Lasso Tool atau Quick
Selection Tool.

Klik pada ikon Create new fill or adjustment
layer di panel Layers, kemudian pilih
Hue/Saturation.

Atur slider Hue, Saturation, dan Lightness untuk

mengubah warna objek sesuai keinginan.

Solid Color Fill:

Buat seleksi pada objek yang ingin diwarnai.



Klik pada ikon Create new fill or adjustment
layer, lalu pilih Solid Color.

Pilih warna yang diinginkan dari Color Picker
dan klik OK.

Sesuaikan blending mode dari layer tersebut
(misalnya, Multiply, Overlay) untuk
mendapatkan efek yang diinginkan.

3. Menggunakan Alat Gradient

Gradient Tool memungkinkan Anda

mengaplikasikan gradasi warna pada objek, menciptakan

transisi warna yang halus dan menarik.

Langkah-langkah:

Pilih Gradient Tool dari toolbar (tekan G sebagai
pintasan keyboard).

Pilih jenis gradasi dan warna dari opsi di bagian
atas layar.

Klik dan seret di atas objek untuk menerapkan
gradasi. Anda dapat mengatur sudut, skala, dan
gaya gradasi (linear, radial, dlIl.) sesuai
kebutuhan.

4. Menggunakan Alat Paint Bucket (Ember Cat)



Paint Bucket Tool digunakan untuk mengisi area
yang dipilih dengan warna solid. Ini sangat berguna
untuk pewarnaan cepat pada area yang besar.
Langkah-langkah:

o Pilih Paint Bucket Tool dari toolbar (tekan G,
dan jika tidak muncul, tahan tombol G untuk
membuka opsi alat dan pilih Paint Bucket Tool).

e Pilih warna dari Color Picker.

o KIlik pada area yang diinginkan untuk mengisi
warna. Pastikan layer yang ingin diwarnai sudah
dipilih.

5. Menggunakan Blending Options

Blending  Options  pada  Layer  Styles
memungkinkan Anda untuk mengubah warna objek
dengan berbagai efek pencampuran yang tersedia di
Photoshop.

Langkah-langkah:

o Kilik kanan pada layer objek di panel Layers dan
pilih Blending Options.

o Pilih Color Overlay.



o Pilih warna yang diinginkan dan atur blending
mode serta opacity sesuai kebutuhan.
6. Menggunakan Selective Color
Selective Color memungkinkan Anda mengubah
warna tertentu dalam gambar tanpa mempengaruhi
warna lain. Ini sangat berguna untuk penyesuaian warna
yang presisi.
Langkah-langkah:
o KIlik pada ikon Create new fill or adjustment
layer, lalu pilih Selective Color.
e Pilih warna yang ingin diubah dari menu
dropdown Colors.
e Atur slider untuk Cyan, Magenta, Yellow, dan
Black untuk mengubah warna tersebut.
7. Menggunakan Layer Mask
Layer Mask memungkinkan Anda menerapkan
perubahan warna hanya pada bagian tertentu dari objek,
tanpa mempengaruhi area lain. Teknik ini sangat
berguna untuk pewarnaan yang lebih detail dan presisi.
Langkah-langkah:



Tambahkan layer adjustment atau fill (seperti
Hue/Saturation atau Solid Color).

Klik ikon Add Layer Mask di panel Layers.
Gunakan Brush Tool dengan warna hitam untuk
melukis pada mask dan menyembunyikan
perubahan warna pada area tertentu, atau dengan
warna putihn untuk menampilkan perubahan

warna.

8. Menggunakan Clip to Layer (Potong ke Lapisan)

Teknik ini digunakan untuk membatasi efek warna

hanya pada satu layer tertentu tanpa mempengaruhi layer

lainnya.

Langkah-langkah:

Tempatkan layer warna (Solid Color, Gradient,
atau Adjustment Layer) di atas layer objek.
Klik kanan pada layer warna dan pilih Create

Clipping Mask.

Photoshop menawarkan berbagai alat dan teknik untuk

memberi warna pada objek. Dengan menguasai metode-

metode ini, Anda dapat dengan mudah menyesuaikan



dan meningkatkan tampilan visual objek dalam proyek
desain Anda. Pilih alat dan teknik yang paling sesuai
dengan kebutuhan spesifik Anda untuk hasil yang
optimal.

C. Memberi Tulisan Pada Objek

Menambahkan tulisan pada objek di Photoshop
adalah proses penting dalam desain grafis, yang
memungkinkan Anda untuk menambahkan teks sebagai
elemen desain atau informasi pada gambar. Photoshop
menyediakan berbagai alat dan fitur untuk menambahkan
dan mengatur teks sesuai kebutuhan Anda. Berikut
adalah penjelasan lengkap tentang cara memberi tulisan
pada objek di Photoshop:
1. Menggunakan Horizontal Type Tool (Alat Teks
Horizontal)

Horizontal Type Tool adalah alat utama yang
digunakan untuk menambahkan teks di Photoshop.
Langkah-langkah:



1. Pilih Alat Teks:

o KIlik ikon Horizontal Type Tool di toolbar

atau tekan T sebagai pintasan keyboard.
2. Kilik dan Ketik:

o KIlik di area gambar di mana Anda ingin

menambahkan teks dan mulai mengetik.
3. Sesuaikan Teks:

o Gunakan panel Character dan Paragraph
(Window > Character dan Window >
Paragraph) untuk menyesuaikan font,
ukuran, warna, spasi huruf, dan atribut
teks lainnya.

4. Pindahkan dan Sesuaikan Posisi:

o Gunakan Move Tool (tekan V sebagai
pintasan keyboard) untuk memindahkan
teks ke posisi yang diinginkan.

2. Menggunakan Vertical Type Tool (Alat Teks
Vertikal)

Vertical Type Tool memungkinkan Anda
menambahkan teks secara vertikal, yang bisa berguna

untuk desain tertentu.



Langkah-langkah:
1. Pilih Alat Teks Vertikal:

o Klik dan tahan ikon Horizontal Type Tool
di toolbar untuk membuka opsi alat teks,
lalu pilih Vertical Type Tool.

2. Kilik dan Ketik:

o KiIik di area gambar di mana Anda ingin
menambahkan teks vertikal dan mulai
mengetik.

3. Sesuaikan Teks:

o Gunakan panel Character dan Paragraph
untuk  menyesuaikan  teks  sesuai
kebutuhan.

3. Menambahkan Efek pada Teks
Photoshop memungkinkan Anda untuk
menambahkan berbagai efek pada teks untuk
membuatnya lebih menarik.
Langkah-langkah:
1. Pilih Layer Teks:



o Pastikan layer teks yang ingin Anda
tambahkan efek sudah dipilih di panel
Layers.
2. Buka Blending Options:
o Klik kanan pada layer teks dan pilih
Blending Options.
3. Tambahkan Efek:
o Centang kotak efek yang diinginkan
seperti Drop Shadow, Stroke, Outer
Glow, atau Bevel and Emboss.
o Sesuaikan  pengaturan efek  untuk
mendapatkan hasil yang diinginkan.
4. Menggunakan Warp Text (Membentuk Teks)
Warp Text memungkinkan Anda membentuk teks
menjadi berbagai bentuk dan gaya.
Langkah-langkah:
1. Pilih Layer Teks:
o Pilih layer teks yang ingin Anda bentuk.
2. Pilih Warp Text:



o KIlik ikon Create Warped Text di toolbar
atas (ikon ini terlihat seperti huruf T
dengan busur di bawahnya).
3. Pilih Gaya Warp:
o Pilih gaya warp dari menu dropdown dan
sesuaikan pengaturan seperti  Bend,
Horizontal Distortion, dan Vertical
Distortion.
5. Menggabungkan Teks dengan Objek
Menggunakan Clipping Mask
Clipping Mask memungkinkan Anda
menggabungkan teks dengan objek atau gambar,
membuat teks tampak seperti mengambil tekstur atau
warna dari layer di bawahnya.
Langkah-langkah:
1. Buat Teks:
o Tambahkan teks seperti biasa
menggunakan Horizontal Type Tool atau
Vertical Type Tool.
2. Posisikan Teks di Atas Layer Objek:



o Pastikan layer teks berada di atas layer
objek atau gambar yang ingin digunakan
sebagai clipping mask.

3. Buat Clipping Mask:

o Klik kanan pada layer teks dan pilih

Create Clipping Mask.
6. Menggunakan Shape Tool untuk Teks di Dalam
Bentuk
Anda bisa memasukkan teks ke dalam bentuk
untuk desain yang lebih kreatif.
Langkah-langkah:
1. Buat Bentuk:

o Pilih alat Shape dari toolbar dan gambar

bentuk di area kerja.
2. Pilih Alat Teks:

o Pilih Horizontal Type Tool atau Vertical
Type Tool.

3. KIlik di Dalam Bentuk:

o Klik di dalam bentuk yang telah dibuat
dan mulailah mengetik. Teks akan

mengisi bentuk yang telah Anda gambar.



7. Menyesuaikan Teks dengan Path
Anda juga bisa membuat teks mengikuti garis atau
path yang Anda buat dengan Pen Tool atau alat bentuk
lainnya.
Langkah-langkah:
1. Buat Path:
o Pilih Pen Tool atau alat Shape dan
gambar path di area kerja.
2. Pilih Alat Teks:
o Pilih Horizontal Type Tool atau Vertical
Type Tool.
3. Klik pada Path:
o Klik pada path yang telah dibuat dan
mulailah mengetik. Teks akan mengikuti

jalur path.

Dengan berbagai alat dan teknik yang tersedia di
Photoshop, Anda dapat dengan mudah menambahkan dan
mengatur teks pada objek untuk menciptakan desain yang
menarik dan informatif. Menguasai berbagai metode ini



memungkinkan Anda untuk lebih fleksibel dan kreatif

dalam pekerjaan desain grafis Anda.
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para ahli, sehingga pembaca dapat mengaplikasikan
ilmu yang diperoleh secara langsung. Dengan
pendekatan yang mudah dipahami dan disertai dengan

ilustrasi yang mendalam, buku ini cocok untuk pemula

hingga profesional yang ingin memperdalam
pengetahuan dan keterampilan mereka dalam bidang

multimedia dan desain grafis.”
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